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About this Tutorial  
 
This tutorial was developed to take budget staff through the sequential steps of building an initial 
allotment submittal using The Allotment System (TALS) Allotment Management and Review (AMR). 
The sample allotment submittal created in this tutorial is developed using the most basic features of 
TALS AMR. It is recommended that users with the various TALS AMR security access levels (Budget 
Operations, Edit Access, and Read-only) should complete this tutorial. The tutorial will outline 
differences in access and system usage based on security level where it applies.   
 
The tutorial can be used in a formal training session, for individual practice, or for developing the 
agency allotment submittal. Some tutorial conventions: 

 Actual values to be entered when using for training or for practice are highlighted.  

 Functions to use will be in Bold.   
 If using on your own, please use your judgment to determine values to be used for practice or 

actual allotment development.  

 Each task is preceded by a brief explanation of the task, its importance in your allotment 
development, and general business rules. 

  Specific business rules and recommendations for entering your allotment submittals are 
denoted with a  under the task.  

 Additionally, Appendix 1 contains a central listing of all the business rules.  

 
Every effort is made to ensure that the TALS AMR tutorial and OFM Allotment Instructions agree in 
every way. In cases where a discrepancy exists, the OFM Allotment Instructions take precedence. The 
OFM Allotment Instructions can be found at http://www.ofm.wa.gov/budget/instructions/default.asp   
 
The TALS AMR Tutorial is available online in the BASS Help Library at  
 
http://bass.ofm.wa.gov/BASSPR/library/default.htm   - or – 
 
https://fortress.wa.gov/ofm/bass/BASSPR/library/default.htm for those using Fortress.  
 
The library may also be accessed by the help links available in all BASS applications.  You can also 
contact the Department of Enterprise Services (DES) Solutions Center at (360) 407-9100 option 2 or  
e-mail the DES Solutions Center at solutioncenter@des.wa.gov. 

http://www.ofm.wa.gov/budget/instructions/default.asp
http://bass.ofm.wa.gov/BASSPR/library/default.htm
https://fortress.wa.gov/ofm/bass/BASSPR/library/default.htm
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Getting Started – Logging on to TALS and System Navigation 
 

1. Open Internet Explorer and enter the login address http://bass.ofm.wa.gov/BASSLogon_pr/  (or 
https://fortress.wa.gov/ofm/bass/BASSLogon_pr/ for those using Fortress) in the address bar of 
the browser. 
If in a training session, use the link provided in class. 
 

2. Use your login ID and password to log in to BASS. If you do not have a login ID and 
password, a security form can be found in the BASS library at the appropriate site listed on 
page 4. 
If in a training session, use the login ID and password provided in class. 

 
3. Select the pie chart icon for TALS AMR (The Allotment System – Allotment Management and 

Review). 
 

 
 

 
 
 

http://bass.ofm.wa.gov/BASSLogon_pr/
https://fortress.wa.gov/ofm/bass/BASSLogon_pr/
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All navigation bars and selection tabs are in the same place on every page. The selection tabs run 
horizontally across the top of each screen, allowing for the selection of screen features and system 
navigation. Shortcut links on the application tab bar (3) and the breadcrumb bar (4) allow for the 
ability to “jump” to previously viewed pages without using the browser Back button.  
 
How to Disable Pop-Up Blockers 

 
 Note:  In order for the application to work, you must disable your pop up blocker for this site.  The 
easiest way to do this if your security is set to block pop ups, is to take the following actions when the 
message below appears as you try to work in the application: 
 

 
 

 

Click on  and the following choices will 
appear: 
 

  
 

 
Choose “Always Allow Pop-ups from this Site…”  This will put the site in your security settings 
automatically. 
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Or, while in Internet Explorer, select Tools, Pop-up Blocker, Pop-up Blocker Settings as seen below: 
 
 

 
 

 
This will bring you to the following: 
 
 

 
 

 
Type in under the “Address of Web Site to allow:” bass.ofm.wa.gov or fortress.wa.gov and click Add. 



 8 

Key Navigation Features 
 

 
1. Internet browser navigation buttons.   Note: The BASS suite of applications does not 

support the use of internet browser navigation buttons, i.e. ‘back arrow’ and ‘forward arrow’. 
You should avoid using the back arrow and forward arrow buttons available on your web 
browser tool bar when working in BASS.  Using these buttons will give unpredictable results 
depending on the screen you are on when used.     

2. Page Header includes Application Title (Allotment Management & Review) and Logout 
Link.   Note:  It is extremely important to properly logout of the system when not in use.  
There is a timeout provision included in the system.  If your session is inactive for 120 minutes 
the system will time you out.  Your packet may be flagged as “in use.”    If you login again with 
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the same user ID it will clear the in use flag and you will be able to access your packet. The in 
use flag will be removed nightly.  You will know a packet has been flagged as in use when you 
try to work with it and it the system tells you that someone is using it. 

3. Application Tab Bar is always available, and includes a tab for each major functional area in 
the system including View Packet List, Online Views, Enterprise Reporting, and Charts.  

• The View Packet List tab enables you to view a list of the agency’s allotment packets 
for the biennium and to navigate to all the detail related to a chosen packet.   

• The Online Views tab allows you to view allotment data for analytical purposes.  See 
Lesson 11 – Online Views for more information. 

• The Enterprise Reporting tab opens up the Enterprise Reporting login page.  See 
Lesson 15 – Reports for more information. 

• The Charts tab allows you to run a variety of charts displaying allotment (pending, 
review and approved packet information only) vs. actual data.  See Lesson 14 – Chart 
Features for more information. 

4. Breadcrumb Bar serves as a trail to navigate back to any previously viewed screen in the 
application.  The breadcrumb bar is dynamic in that any given page will show a different 
breadcrumb trail based on how the page was reached.  

 

Closer look at Breadcrumbs below: 
 

 
 

5. Biennium Selection Box—allows you to choose which biennium you wish to work with. 

6. Row Selection Box—allows you to choose how many rows of data you would like to see with 
the choice of 10, 20, 30 or All.  This makes it so you can scroll to choose a packet rather than 
go from page to page.   Note:  The row selection box can be found on the view packet list, 
allotment coding structure and allotment details screens. 

7. Biennium and Row Load Button—after you choose the biennium and number of rows you 
would like to see; you must hit the Load button to get what you asked for. 

8. BASS Contact, BASS Help and Logout -- includes BASS Home link which takes you to the 
BASS system main menu page, Contact BASS link which tells how to contact the BASS help 
staff, and BASS Help link which takes you to BASS Help documentation. 
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LESSON 1 – PREPARE AN ALLOTMENT PACKET 
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Lesson 1, Task 1 – Establish an AMR Allotment Packet 
 
Allotments are detailed plans (or amendments to plans) of the scheduled revenues and expenditures 
authorized in the budget and the related cash receipts and cash disbursements.   Agencies submit these 
allotment plans to OFM for review using the TALS AMR system.   Prior to entering new allotment 
data into AMR, the agency needs to establish a new allotment packet. An allotment packet is a 
container in which allotment records are created for a specific allotment purpose.  
 
The Add Packet feature creates a new allotment packet on the View Packet List screen.  This packet 
will be assigned a system generated four digit number used to identify the allotment packet and will 
display descriptive information pertaining to the packet.    Note:  This feature is not available for 
those with read only security access. 
 
The following steps will take you through entering the new allotment packet with the appropriate 
packet descriptive elements, adding narrative comments that support the allotment, as well as, adding 
attachments that will be needed by an OFM budget analyst in the allotment review process. 
 
After Logging in to TALS AMR, the View Packet List screen is displayed. See below. 
 
 

 
 

1. Select the appropriate Biennium using the dropdown box, and then the Load button.    
Note:  You will know the data is loading by the status bar in the lower right hand corner.  This 
shows quickly, so you might miss it. 
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2. Select the Add Packet tab in the upper left hand corner of the View Packet List screen. 
 

3. On the Add Packet screen,   Note:  The Packet Number will remain listed as [unassigned] 
until the required packet elements have been selected and saved for the packet being added.  
This is a system generated number and deleted packet numbers will not be reused. See below. 
 

4. Verify the Biennium.  Note:  This dropdown will default to the biennium selected on the 
View Packet List screen.  Once a packet has been saved this field cannot be updated. 

 

5. Select a packet type from the Purpose dropdown box.  Note: The packet purpose describes 
the reason for the allotment submittal.  The initial allotment requires an initial allotment packet 
purpose type.  Please see the allotment instructions for more information on the correct packet 
purpose to use for allotment amendments. 

Operating Initial Allotment 
 

6. Program.  Note:  The dropdown list displays official agency programs.  This is required for 
DSHS.   
No program is needed for this task. 

To forgo assigning a program for the packet, verify that the Program field displays [No 
Program Selected].  

 

7. Enter a packet Title that provides a quick description for further reference.   
Working Draft of Initial Allotment Data 

 

8. Enter a Packet Explanation for information needing to be communicated to your OFM budget 
analyst.  Note:  Field is not required to save an allotment packet, but an explanation is 
required by the OFM allotment instructions in certain cases. Explanation text is required for 
official allotment submittals when a pre-release edit check warning message requires an 
explanation. This text is visible to your OFM budget analyst.    
Staff month increase in September and October of 2007 for Program 100 due to enhancement 
package approved by the Legislature.    

 

9. Enter Agency Internal Comments that capture detailed agency assumptions.   Note:  For 
informational use for the agency.   
Budget and Accounting Manager to review policy decisions with agency director at May 
retreat.  Program 200 assumptions in staffing have not been approved. 

 

10. Select an individual from the Primary Contact dropdown list who is the agency spokesperson 
for questions concerning the allotment data and its assumptions.   Note:  The contact field is 
populated based on security forms submitted to BASS.  The chosen contact will be the person 
receiving e-mail issues in relation to the packet.     Note:  The contact can be changed in 
review and approved status. 
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Verify your name is listed in the contact field.  If in a training session, skip this part. 

 

11. Select an individual from the Secondary Contact dropdown list who is a secondary contact for 
you agency. 

 

12. Attachments.   Note:  Optional field, except for unanticipated receipts.  If adding a packet, 
the Add Attachments button will only be enabled after the packet details have been saved. 

 Select the Save tab. 
 

 

 
 
 
Field Required?    Notes 
A. Biennium Yes Once a packet has been saved, this field cannot be updated. 

B. Purpose Yes Describes the purpose or type of allotment. Once a packet has been 
saved, this field cannot be updated.   

C. Program No, except 
DSHS 

For informational use to quickly identify and sort allotment packets that 
contain allotment detail for one program. There is no system edit 
between the Program field selection and the allotment detail included 
in the packet. 
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Field Required?    Notes 
D. Title No For informational use to quickly identify and describe the allotment 

packets data. Visible on the View Packets List screen.  This field can 
be updated for an allotment packet with a packet status of Draft or 
Returned. 

E. Packet 
Explanation 

Sometimes Use this field to communicate to OFM the key assumptions and 
decisions in the allotment packet data.   While this field is not required 
to save a packet, the OFM allotment instructions do require agencies 
to submit explanations in certain cases. 

F. Agency Internal 
Comment 

No Comments visible only to the agency.   Used to document agency 
decisions and assumptions for the allotment packet data.   

G. Primary 
Contact 

Yes The field is required, and defaults to the contact name, e-mail address, 
and phone number of the person who created the packet.   

H.  Secondary 
Contacts 

No You may select up to two more contacts, the email address and phone 
number will display, once selected. 

I. Attachments No You may attach Word, Excel and PDF files. 

J. Lock Packet No Allows staff with budget operations security to lock packets.   Once 
saved a lock will appear to the left of packet number and the Lock 
Packet title will change to Unlock Packet.  To unlock, simply click on 
the Unlock packet selection box and save again. This function can 
also be performed from the View Packet List Screen by choosing the 
Set Locks option. 

K. Packet Number Automatic Automatically assigned by the application.  Until the packet is saved it 
will display as [unassigned]. 

L. Status Automatic Will remain in Draft status until the packet has been released for 
review by an OFM budget analyst for official packets or submitted for 
posting to AFRS for internal packets. 

 
 
 
 
RESULTS * You have created a container into which you can enter your allotment spending plan.  
See below. 
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TO DO - Hands on: Create three more packets.  Create at least one capital packet.   Note: It is 
intended that all agencies, except DSHS, submit one packet for initial Operating and one for initial 
Capital allotments, if appropriate.  DSHS must create separate initial operating packets for each 
program and submit all of these packets at the same time. 
 
 
 
 
 
 
 
Lesson 1, Task 2 – Include Packet Attachments  
 
TALS AMR supports Excel, Word, and PDF formats.  Documents attached to an allotment packet are 
saved to the TALS AMR database.  Attachments added become an artifact of the allotment packet, and 
are available for viewing until the packet is deleted.  For modifications to documents previously 
attached, you must update the document on your agency network or workstation, and delete and 
reattach to the allotment packet in AMR.  Unanticipated receipt allotment packets should include 
attachments for the Grant and Award documentation, prior to submitting for OFM budget analyst 
review and approval.   
 
 Note:  You must save your packet before it will allow you to add an attachment. 
 Note:  Attachment files are limited in size to 3MB. 

 
1. On the Add Packet screen or Update Packet screen, select the Add selection tab, located on the 

right hand side of the screen. 
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2. The Add Attachment dialogue box will display.  See below. 
 

 
 

3. Select the Browse button to search on your agency network or workstation for the document to 
be attached for your allotment packet. 

 
4. After locating the document, double click the file name or single click and click the open 

button.  The Choose file dialogue box will close upon your selection of the file. 
Locate an excel document on the training room workstation. 

 
5. Verify that the selected attachment name and file location displays in the field to the left of the 

browse button. 
 
6. Enter a description of the document for future reference.  Note:  The Description field is 

optional, and provides the ability to include a synopsis of the material for quick reference.  The 
description included will display on the View/Add/Update Packet screens. 
Spreadsheet contains FTE breakdown for Program 200. 

 
7. Select the Attach button. A dialog box will display “File Uploaded!”  Click Ok.  Close the 

Add Attachment Dialog box by choosing cancel or “X” out of it.  The attached file name, file 
type and description now displays in the attachment section of the screen.  See below. 
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8. View the newly added file. Click the attachment selector (circle to the left of the file name), 

and then select the View tab.  Note: The file must be selected prior to clicking the View tab.  
The following toolbox will be displayed: 
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9. Click Open Attachment to display the dialog box below. If the “Always ask before opening 
the type of file” box is unchecked, the dialog box will not display.   Note:  The view 
attachment toolbox will remain open even after you have closed the attachment.  To close, “X” 
out of it.   

 

 
 

10.  Click Open, then look at the attachment and close the file. 
 

11. If this is the wrong attachment or it is not necessary, simply click the attachment selector and 
click the Delete button in the attachment section of the screen.  Do not do this at this time.  
Instead, click Save. 

 
12. Go back to the View Packet List screen. 

 
RESULTS *  You have added an attachment to your allotment packet.  See below. 
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TO DO – Hands on:  Add a Word and PDF attachment to the packet.  
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Lesson 1, Task 3 – View Packet List (View/Update, Delete and Set Packet Locks)  
The View Packet List screen enables you to view a list of the agency’s allotment packets for the 
selected biennium.    Note:  Your security access will determine which functions are available to 
you.  There are three levels of security access: Read only, edit access and budget operations. 
 
 

 
1. Activities Bar—allows you to perform actions related to a chosen packet or to add a packet.  

This includes View Packet, Add Packet, Update Packet, View History, Delete, Set Locks, 
Allotments, Import, Export, Copy and Review Issues.   

• The View Packet allows you to look at the packet container information.   

• The Add Packet tab allows you to add a new packet.   

• The Update Packet tab allows you to update information in the packet container excluding 
Biennium, Purpose and Contact.   

• The View History tab allows you to see actions that have been taken on the packet 
including the action, the user ID, the date and the time.   

• The Delete tab allows you to delete a packet.   

• The Set Locks tab allows budget operations staff to lock and unlock packets.   

• The Allotments tab allows you to go into the allotment information of the packet.  See 
Lesson 2 – Create the Expenditure Allotment Data through Lesson 5 – Create the Revenue 
Allotment Data for more information. 

• The Import tab allows you to import data into the packet.  See Lesson 9 – Import Text File 
and Lesson 10 - Import SPS Data for more information. 
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• The Export tab allows you to export data out of the packet to change or use in other 
packets.  This information remains in the original packet.  See Lesson 8 - Export for more 
information. 

• The Copy tab allows you to copy data from one packet into another packet.  See Lesson 6 – 
Copy Features for more information. 

• The Review Issues tab allows you to see issues created by OFM and respond or to create 
new issues.  See Lesson 12 – Review Issues for more information. 

2. Packet Selection Box—allows you to work with a particular packet or packets. 

3. Packet Lock Indicator—displays a lock symbol when packet lock is set. 

4. Packet Attachment Indicator—displays a paperclip if an attachment has been added to the 
packet. 

5. Page Indicator—specifies the page you are on.  The number without the underline is the page 
you are on. 

6. Traffic Light Indicator—shows where you are in the AFRS edit check process and the 
submittal process.  You will see a green, yellow, red or no traffic light depending on where you 
are in this process.  See Lesson 13 – Pre-Release Edit Check for more information. 

7. Packet Number—number automatically assigned by the system and is the default sort showing 
the most recent packets first, descending order.  Deleted Packet # will not be reused. 

8. Packet Purpose—displays what type of packet it is i.e. operating initial allotment, operating 
internal adjustments, Capital 1st supplemental. 

9. Packet Title—displays chosen title. 

10. Packet Status: Draft, Pending, Review, Returned, and Approved.   

11. Packet Program—displays number and title if populated when packet was created. 

12. Displays check mark if allotment packet contains expenditure data. 

13. Displays check mark if allotment packet contains cash disbursement data. 

14. Displays check mark if allotment packet contains cash receipt data. 

15. Displays check mark if allotment packet contains revenue data. 

16. Displays check mark if allotment packet contains agency external comments. 

17. Displays check mark if allotment packet contains agency internal comments. 

18. Last update—displays the last user that edited the packet.  Holding your cursor over this field 
displays a tool tip with the date and time of the last edit to the packet. 

19. Creator—displays the user that created the packet. 

20. Action/Report Selection Drop Down Box—allows you to choose certain actions to perform 
on your chosen packet(s) and run reports on chosen packets.  See Lesson 13 – Pre-Release Edit 
Check for more information on action selections (AMR Pre-release Edits, AMR AFRS Edits, 
Most Recent Edit Report, Submit Packet(s) and Recall Packet) and Lesson 15 - Reports for 
more information on report selections. This includes: 
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21. Run Button—this triggers what you have chosen from the Action/Report Selection Drop 
Down Box to either perform the task or produce the report. 

 

From the View Packet List screen you can navigate to view, add, or update the packet details.  
Note:  Those with read only access will only be able to view.  Edit access (as long as the packet is 
unlocked) and budget operations can do all three. 

1. Check the Packet Selection box, and then click on the Update Packet tab.   

2. Change Title to: 

Working Draft of Initial Allotment Data Updated 

3.   Save and go back to View Packet List. 
4. Select one of your packets, and then choose the Set Locks tab. 

 Note:  The system will allow you to sort on none, or one or more columns. Each column header has 
three possible states (not sorted—indicated with no arrow, sorted ascending—indicated with an up 
arrow, sorted descending—indicated with a down arrow), which can be selected by clicking the text in 
the column header. On the View Packet List screen, the sort default is Number in descending order. 
 
TO DO – Hands on:  Practice sorting  
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LESSON 2 – CREATE THE EXPENDITURE ALLOTMENT DATA 
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Lesson 2, Task 1 – Add Expenditure Coding Structure & Allotment Detail  
 
After creating a container—the packet—for your allotments, you must next define the program, 
project, and organization coding level detail for any data you want to enter in the packet.   This is 
called the “coding structure.”   
 
 Note:  Coding Structures and Allotment Details can be added and updated for any packet in a 
status of draft or returned. 
 
To add, update, delete, or view coding structures for a packet, place a check mark in the packet 
selection box and select the Allotments tab.  
 
 Note:  The Breadcrumb Bar now includes the Allotment Coding Structure. 
 
The Component Navigation Bar provides the means to switch between the four allotment components 
(Expenditures, Cash Disbursements, Cash Receipts and Revenue).  The highlighted “tab” indicates the 
component which is currently being viewed, and displays all coding structure records established for 
the component.  In the diagram below, Expenditures is the selected component.   
 

 
 

The Activities Bar allows you to perform actions related to a chosen coding.  This includes Add, 
Update, Delete, Allotment Details, Comments, Pattern (only on the Cash Disbursements and the 
Cash Receipts components) and Copy.   

• The Add tab allows you to add a new coding structure.   

• The Update tab allows you to update a coding structure. 
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• The Delete tab allows you to delete a coding structure.   

• The Allotment Details tab allows you to add, update, and delete the detail related to a 
chosen coding structure. 

• The Comments tab is a place where you can make comments about the entire component 
(expenditure, cash disbursements, cash receipts or revenue.)     Note:  The comment tab 
within coding structure is where you put comments referred to in the Pre-Release Edits as 
component level comments. The copy tab allows you to copy coding structures.  See Lesson 
6 – Copy Features for more information. 

• The Pattern tab allows you to create a pattern for cash receipts and cash disbursements.  See 
Lesson 3 – Create the Cash Disbursement Allotment Data and Lesson 4 – Create the Cash 
Receipts Allotment Data for more information. 

 Note:  The allotment coding structure screen also includes a row selection box which allows 
you to choose how many rows of data you would like to see with the choice of 10, 20, 30 or All.  To 
get this to display the number of rows, make a selection and click Load. 

 
First you must create the coding structure. 

 
1. Click Add while in the Expenditures tab. 
 
2. The following Dialog box will be displayed: 
 

 
 

3. A highlighted selection box appears for program index [Enter or Select a Program Index]   
Note:  This is a required field. 

4. Add a program index.   Note:  While the [Enter or Select a Program Index] box is 
highlighted you can hit the keyboard down arrow to see all program indexes available in your 
agency, or you can start typing which will bring up a series of program indexes, or type in the 
whole thing.  If the agency has many program indexes, it cannot hold them all and will show a 
‘…’ at the bottom.  To get to the codes further down you will need to start typing to reach them.  
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5. If you allot at the lower levels (Organization Index, AFRS Project, AFRS Sub Project, AFRS 
Project Phase, Budget Unit, Budget Activity, User Defined) the rest of the coding structure 
operates the same as program index.   Note:  Only program index is required, the rest of the 
coding structure is optional.   Note:  Project is a hierarchical field, so if you want to enter a 
sub project you must enter a project first or if you want to enter a project phase you must enter 
both project and sub project first. 

6. Add additional coding structure by hitting the down arrow in the program index field, choose a 
program index, then hit save.     Note: To add additional coding you can choose the Add 
button at the bottom of the screen.   Note:  By clicking the “Add” button the data is saved 
automatically; however, after the last code make sure to click the “Save” button. 

7. To leave the dialog box click cancel or “X” out of it. 

 
Now that you have established a coding structure, you may enter allotment data for that structure.  
TALS refers to allotment data as Allotment Details.  To add or view allotment details for a coding 
structure, place a check mark in the coding structure selection box and select the Allot. Details tab.  
 Note:  Allotment details can only be added for an existing coding structure and only 1 coding 
structure can be selected at a time.  See below. 
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 Note:  You have the ability to hide or expand grid details from view on the Expenditure Allotment 
Details screen.  By selecting the ‘+’ plus symbol to the left of the grid title, the grid expands for adding 
or viewing details.  Likewise the ‘-’ negative symbol to the left of the grid title collapses the grid. By 
default the only grid expanded on entry of a coding structure with no allotment details is Expenditure 
Allotment Details.   
 
 Note:  The allotment coding structure screen also includes a row selection box which allows you to 
choose how many rows of data you would like to see with the choice of 10, 20, 30 or All for all four 
components.  To get this to display the number of rows, make a selection and click Load. 
 
 
Steps for Option 1 agencies – Add Allotment Detail: 
 
Option 1 agencies are required to enter both an Expenditure Authority Index and an Object when 
adding allotment detail.  However, for Option 1 agencies these two required fields are entered as 
separate allotment detail records within the same coding structure. If you are an Option 2 agency skip 
steps 1 through 6. 
 

1. To add expenditure allotment detail, click the Add tab within the allotment details.   
 
2. The following dialog box appears: 
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3. Choose an EAI (Expenditure Authority Index is also referred to as Appropriation Index or AI) 
by clicking the down arrow or typing in the EAI, now the Object, Sub Object and Sub Sub 
Object are disabled.  Enter fiscal year dollar amounts by month and click Save.   

 
 Note:  Expenditure Authority Index and Object are required allotment detail fields for both 
option 1 and option 2 agencies.  For option 1 agencies these two required fields are entered as 
separate allotment details within the same coding structure.   Note:  The EAI determines what 
fiscal period dollar amounts will be available.  For example if you choose a first year EAI, the 
second year dollar amounts will be grayed out and not available for input.     Note:  For records 
that have an EAI that cannot be found in the statewide tables, the fiscal period is assumed to be 
Biennial.   
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4.  Click Add, then choose an Object and Sub Object, now the EAI is disabled.  Enter fiscal year 

dollar amounts by month and Save. 
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5.  Add further allotment details by clicking the Add selection box and following step 3.     
 
6.  Exit the dialog box by hitting cancel or “X”. 
  

 Note:  For Option 1 Agencies when there is a variance the variance is displayed in the expenditure 
grid under variance.  Variance displays the difference between the sum of the objects and the sum of 
the appropriation indexes for each month.  See below.  
 

 
 
 Note:  The Expenditure Allotment Details screen also includes a row selection box which allows 
you to choose how many rows of data you would like to see with the choice of 10, 20, 30 or All.  To get 
this to display the number of rows, make a selection and click Load.   
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Steps for Option 2 agencies – Add Allotment Detail: 
 
Option 2 agencies are required to enter both an EAI (Expenditure Authority Index) and an Object from 
the Add Expenditure Allotment Detail screen.  If you are an Option 1 agency, skip steps 7 through 11. 
 

1. To add expenditure allotment detail, click the Add tab within the allotment details.   
 
2. The following dialog box appears: 
 

 
 

3.Choose an EAI (Expenditure Authority Index is also referred to as Appropriation Index Or AI) 
by clicking the down arrow or typing in the EAI, choose an object, and enter fiscal year dollar 
amounts by month and click Save.   
 
 Note:  Expenditure Authority Index and Object are required allotment detail fields for both 
option 1 and option 2 agencies.  For option 1 agencies these two required fields are entered as 
separate allotment details within the same coding structure.  For option 2 agencies, these two 
required fields are entered together in one allotment detail as depicted below.  Note:  The EAI 
determines what fiscal period dollar amounts will be available.  For example if you choose a first 
year EAI, the second year dollar amounts will be grayed out and not available for input.     
Note:  For records that have an EAI that cannot be found in the statewide tables, the fiscal period 
is assumed to be Biennial.   Note:  Once you hit save the dialog box will display as an “update” 
rather than an “add”. 
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4. Add further allotment details by clicking the Add selection box and following step 3.   Note:  
Your allotment detail should equal your EA schedule when complete. 

 
5. Exit the dialog box by hitting cancel or “X”. 

 

 Note:  The Expenditure Allotment Details screen also includes a row selection box which 
allows you to choose how many rows of data you would like to see with the choice of 10, 20, 30 or 
All.  To get this to display the number of rows, make a selection and click Load.   Note:  For 
option 2 agencies: If all details aren’t displayed, the first row “Total” will be a sub-total of all the 
amounts displayed in the grid.  The second row, Grand Total, will be a total of all the amounts if 
multiple pages of data exist.  In the image below the Grand Total would be the total of all the 
amounts on page 1 and 2.  See below.    
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Option 1 and Option 2 agencies: 
 
 Note:  Fiscal month fields are available for input based on the EA code used to establish the 
expenditure authority index.  When updating, if dollars exist in fiscal months not consistent with the 
fiscal period control of the EA code, a Roll amounts button will be available.   See below. 
 

 
 
 Note:  To remove dollar amounts from the read-only fiscal months, you can select a new 
expenditure authority index (consistent with the entry fiscal months) or select the Roll Amounts button.   
 
 Note:  The Roll Amounts button will move dollar amounts to their corresponding fiscal month 
amount for the fiscal year control of the EAI. (For example: an EAI with a Fiscal Year 2 control, 
Fiscal Month 1 dollars are moved to Fiscal Month 13.)   See below. 
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TO DO – Hands On:  Practice Allotment Detail. 
 
 Note:  Within Allotment Details for allotted expenditures and FTEs (as well as cash disbursements, 
cash receipts and revenue) you have several choices on how to enter the dollar amounts.  You can 
manually enter them one at a time, paste them from an excel spreadsheet, enter one amount to repeat 
over the fiscal period, enter one amount to spread over the fiscal period, or enter one amount to 
spread quarterly over the fiscal period.  It is always recommended that you choose your EAI first to 
determine which dollar fields should be available to enter into. 
 

1. Add allotment detail dollar amounts using the manual process.   Note:  To enter dollar 
amounts manually you can use the tab and enter keys or highlight the dollar amount and do a 
Ctrl “C” for copy and go to the next dollar amount area and do a Ctrl “V” for paste. 

 
2. Add allotment detail dollar amounts using the paste function.   Note:  To enter dollar 

amounts using the paste function choose dollar amounts from an excel spreadsheet going either 
vertically or horizontally by highlighting them and doing either an edit/copy or Ctrl C, then 
click in the fiscal month you want to start pasting in, then click the paste button.  You can paste 
up to 24 dollar amounts; however, if you choose more amounts than you have months it will 
only paste the first 24 if a biennial EAI, or 12 if a fiscal year EAI.  So be careful to choose the 
right beginning month when pasting dollar amounts. 

3. Add allotment detail dollar amounts using the repeat function.   Note:  To enter dollar 
amounts using the repeat function choose which month you want it to start and then enter the 
amount you want repeated, then click the repeat button. 
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4. Add allotment detail dollar amounts using the spread function.   Note:  To enter dollar 
amounts using the spread function choose which month you want it to start and then enter the 
amount you want spread over the fiscal period.  If necessary, it will round the last month of the 
fiscal period to equal the total amount you wished to spread. 
 
 

5. Add allotment detail dollar amounts using the quarterly function.   Note:  To enter dollar 
amounts using the quarterly function, choose which month you want it to start and then enter 
the amount you want spread quarterly over the fiscal period.  If necessary, it will round the last 
month of the fiscal period to equal the total amount you wished to spread.  If you use this 
function after using the other functions, it will only replace the quarterly amounts. 

 
 
Lesson 2, Task 2 – Add FTE, Unallotted and Reserve Allotment Detail  
 
The application also allows you to enter unallotted, reserve and FTE allotment detail within the 
expenditure component in allotment detail. 
 

1. Choose an existing coding structure by clicking the coding structure selection box or create a 
new structure, then click the Allot. Details tab. 

2. Expand Staff Month Allotment Details and click Add. 

3. The following dialog box will be displayed: 
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4. Choose an Account and enter FTEs by month.  Then click Save, then Cancel.   Note:  If you 
choose Account, EAI will not be available.  If you choose EAI, account will automatically fill 
in.  OFM only requires that FTEs be by GF-S 001 account or 996 for all other; however, you 
can indicate specific accounts detail if you wish.   Note:  You can choose to mark FTEs as 
Interagency FTEs for tracking purposes.   Note:  The Transportation FTE box will be 
automatically flagged if the Account chosen is associated with a transportation Account. 

5.   You have successfully added FTE allotment detail.   
 
 
 
 

6. Expand the Unallotted Allotment Details grid by clicking the ‘+” sign, and then click Add. 
7. The following dialog box will be displayed: 

 

 
 

8. Add a fiscal year one EAI and Fiscal Period Amt., click Add and add a fiscal year two EAI 
and amount and click Save, and then Cancel. 

9. You have added Unallotted allotment detail.  See below: 
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10. Follow steps 1-4 except this time enter information into Reserve Allotment Details.   

 
 
Data Views (Display) - There are currently three different data views in allotment details to select 
from: 

 Biennial (displays 3 total columns and 24 amount columns) 

 Fiscal Year 1 (Displays 1 total column and amount columns 1-12) 

 Fiscal Year 2 (Displays 1 total column and amount columns 13-24) 

 
TO DO – Hands on:  Choose different views to see effects. 
 
Column Locking (Freeze Columns) allows you to select from a drop down certain sets of columns to 
“lock” to the left side of the grid.   Note:  When columns are locked the amount columns scroll 
underneath them. You will only see the scroll bar if the display is smaller than the grid. 
Options are: 
 None (unlocks locked columns) 
 Keys (all code related columns) 
 Keys and Totals (all codes and the FY1, FY2 and Biennial Total columns) 

 
TO DO – Hands On:  Choose different options to see the effects.  Displayed below is the “Keys and 
Totals” option. 
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TO DO – Hands On:  Create coding structure and allotment detail in your previously created 
capital packet.   
 
 Note:  Capital project number is derived by using biennium, EA code (Expenditure Authority 
Index), and agency for all allotments.  For unanticipated receipts this field will only be derived if it has 
been previously entered otherwise, the agency must enter it and it is editable.  For allotments other 
than unanticipated receipts this field is not editable.  In order for the system to derive capital project 
number, you must choose an expenditure authority index associated with a capital appropriation.  The 
dropdown menu returns all expenditure authority indexes valid for the agency, not just capital 
expenditure authority indexes. 
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LESSON 3 – CREATE THE CASH DISBURSEMENT ALLOTMENT 
DATA 
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Lesson 3, Task 1 – Cash Disbursement Coding Structure and Allotment Detail 
 
Agency allotments must include monthly estimates of the cash they will disburse by account.  As an 
agency prepares initial or adjusted expenditure allotments, they almost always will need to include an 
allotment for the related cash disbursements.   Note:  Coding structure is optional for cash 
disbursements allotments; however, the account must be identified as part of the allotment detail. A 
blank coding structure would imply that the cash disbursement is allotted at the agency level.  
 

1. Go to View Packet List, choose a packet, and click the Allotments tab. 

2. On the component navigation bar, select Cash Disbursements. 
3. Select a blank coding structure check box and click the Allot. Details tab, as shown below: 

 

 
 

4. This will bring up the cash disbursements allotment detail grid as shown below:   
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 Note:  The Cash Disbursements Allotment Details screen also includes a row selection box 
which allows you to choose how many rows of data you would like to see with the choice of 10, 20, 
30 or All.  To get this to display the number of rows, make a selection and click Load.   
5. Click the Add tab.  The following dialog box will be displayed: 

 

 
 

6. Choose an Account and enter dollar figures.  Note:  EAI is an optional field.  Account will 
automatically be entered if an EAI is chosen.  Account is a required field. 

 
7. Click Save and exit the dialog box 
 
8. You have successfully added cash disbursement allotment details.  See below: 
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Lesson 3, Task 2 – Patterning Cash Disbursements 
 
A patterning tool is available for creating Cash Disbursement and Cash Receipt Allotment detail for 
the initial allotment.  Patterning allows you to easily create an allotment based on the pattern of actuals 
from the previous biennium.  Note:  Patterning is performed at the account level.  Note:  The 
pattern takes the dollar amount you have entered for the account and prorates it monthly based on the 
previous biennium’s actuals or allotments.   Note:  If all months of the biennium are not final the 
pattern will use the allotment for those months.   Note:  A pattern will only be created for accounts 
that have amounts entered. If the amount is left blank it is considered to be zero and no pattern will be 
created for that account.   It will replace any data previously in that account with a zero.  Note:  A 
pattern cannot be created on an account that did not exist the prior biennium.   Note:  A pattern can 
only be performed using a blank coding structure. 
 

1. Go to the Allotment Coding Structures and select a blank coding structure or create one by 
doing an Add, then Save without entering any information. 

 
2. Select the Pattern tab.  See below. 
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3. The following dialog box will be displayed:  
 

 
 

4.  Add in the total amount you need to pattern for the account codes you wish to pattern.  Then 
click Save.      

 
5. The following warning will be displayed:   Note:  This message does not mean that it will 

delete account data already created in other coding structures.  Be careful not to duplicate 
your cash disbursements by creating coding structures with the same accounts used in 
patterning. 

 

 
 

6. Click OK. 
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7. The following message will be displayed: 
 

 
 

8. Click OK. 
 
9. To view the allotment detail created from using patterns click on the blank coding structure 

selection box, then Allot. Details.  See below for detail: 
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LESSON 4 – CREATE THE CASH RECEIPTS ALLOTMENT DATA 
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Lesson 4, Task 1 – Cash Receipt Coding Structure and Allotment Detail 
 
Agency allotments must include monthly estimates of the cash they will receive by account.  As an 
agency prepares initial or adjusted revenue allotments, they almost always will need to include an 
allotment for the related cash receipts.   Note:  Coding structure is optional for cash receipts 
allotments; however, the account must be identified as part of the allotment detail. A blank coding 
structure would imply that the cash receipt is allotted at the agency level.  
 

1. Go to View Packet List and choose a packet and click the Allotments tab. 

2. On the component navigation bar select Cash Receipts. 
3. Select a blank coding structure check box and click the Allot. Details tab, as shown below: 

 
 

 
 
4. This will bring up the cash receipts allotment detail grid as shown below: 
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 Note:  The Cash Receipts Allotment Details screen also includes a row selection box which 
allows you to choose how many rows of data you would like to see with the choice of 10, 20, 30 or 
All.  To get this to display the number of rows, make a selection and click Load.   
 
5. Click the Add tab.  The following dialog box will be displayed: 

 

 
 

6. Choose an Account and enter dollar amounts.      Note:  Account is a required field while 
major source and source are optional fields for cash receipt allotments. 

7. Click Save and exit the dialog box. 

8. You have successfully added cash receipts allotment details.  See below: 
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Lesson 4, Task 2 – Patterning Cash Receipts 
 
A patterning tool is available for creating Cash Disbursement and Cash Receipt Allotment detail in the 
initial packet only.  Patterning allows you to easily create an allotment based on the pattern of actuals 
from the previous biennium.  Note:  Patterning is performed at the account level.  Note:  The 
pattern takes the dollar amount you have entered for the account and prorates it monthly based on the 
previous biennium’s actuals or allotments.   Note:  If all months of the biennium are not final the 
pattern will use the allotment for those months.   Note:  A pattern will only be created for accounts 
that have amounts entered. If the amount is left blank it is considered to be zero and no pattern will be 
created for that account.   It will replace any data previously in that account with a zero.  Note:  A 
pattern cannot be created on an account that did not exist the prior biennium.   Note:  A pattern can 
only be performed using a blank coding structure. 
 

1. Go to the Allotment Coding Structure and select a blank coding structure or create one by 
doing an Add, then Save without entering any information. 

2. Then select the Pattern tab as was done in the cash disbursements exercise. 

3. The following dialog box will be displayed: 
 

 
 
 

4. Add in the total amount you need to pattern for the various account codes you wish to pattern.  
Then click Save.    
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5. The following warning will appear.   Note:  This message does not mean that it will delete 
account data already created in other coding structures.  Be careful not to duplicate your cash 
receipts by creating coding structures with the same accounts used in patterning. 

 
 

 
 

6. Click OK. 
7. A message will display “Pattern was successful” as it did in the cash disbursements exercise. 

8. Click OK. 
 
9. To view the allotment detail created from using patterns click on the blank coding structure 

selection box, then Allot. Details.  See below for details: 
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LESSON 5 – CREATE THE REVENUE ALLOTMENT DATA 
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Lesson 5, Task 1 – Revenue Coding Structure and Allotment Detail 
 
Revenue allotment information is entered into TALS AMR in a manner similar to the coding structure 
and allotment detail instructions described previously in the tutorial.   Note:  Coding structure is 
optional for revenue allotments; however, the account, major source and source levels must be 
identified as part of the allotment detail.  A blank coding structure means the revenue is allotted at the 
agency level. 
 

1. Go to View Packet List and choose a packet and click the Allotments tab. 

2. On the component navigation bar select Revenue. 
3. Select a blank coding structure check box and click the Allot. Details tab.  Then click the Add 

tab.  The following dialog box will be displayed: 
 

 
 

4. Choose an Account, Major Source and Source and enter dollar amounts.   Note:  EAI is an 
optional field for revenue allotments, but account, major source and source are required.   
Note:  Major source is a hierarchical field, so if you want to enter a source you must enter a 
major source first or if you want to enter sub source you must enter both major source and 
source first.   Note:  The Revenue Allotment Details screen also includes a row selection box 
which allows you to choose how many rows of data you would like to see with the choice of 10, 
20, 30 or All.  To get this to display the number of rows, make a selection and click Load.   

5. Click Save and exit the dialog box. 

6. You have successfully added revenue allotment details.  See below: 
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LESSON 6 – COPY FEATURES 
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Lesson 6, Task 1 – Copy a Packet 
 
To copy a packet means to copy the coding structures and allotment details contained in one packet to 
another packet.  You may select to copy the entire packet or any part of it. 
 

1. Go to View Packet List and choose a packet and click the Copy tab.   Note:  Any packet can 
be copied from, but only packets in draft status can be copied to.   
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In the Copy tab you make your selections. 

 
• Include – is used to include all components or deselect the items not needed. 
• Detail Options – is used to include details or not, to reverse signs, or zero out the amounts. 
• What Action to take – choose between Merge/Sum Amounts Together for Duplicates and 

Delete Original/Replace. 
• To Packet – is used to designate where you want the data being copied to go to. 
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2. The dropdown arrow for Detail Options allows you to: 

• Include Details – includes allotment details and amounts. 
• Include Details/Reverse Signs – includes allotment details and changes all positive 

amounts to negative and all negative amounts to positive. 
• Include Details/Zero Out - includes coding structure and allotment details with no 

amounts. 
• Do Not Include Details – copies only the coding structures.  
 

 
 
 Note:  When a user wants to merge multiple packets and reverse the signs, here are the steps:  
First merge all the packets you want to merge into one packet, create a new packet, copy the 
packet with the merged packets into the new packet and reverse the signs. 
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3. Select what action you would like to take: 
• Merge/Sum Amounts Together for Duplicates – this action will add coding structures 

that do not exist in the ‘to’ packet and where there are duplicate coding structures it will 
add the amounts together. 

• Delete Original/Replace – this action will delete everything in the ‘to’ packet and only 
bring in the selected items.  
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4. Select which packet to copy to: 

• Biennium – use the dropdown arrow to select the biennium for the ‘to packet’. 
• Packet Purpose – use the dropdown arrow to select the packet purpose to reduce the 

packets to choose from for the ‘to packet’.   Note:  You do not need to select a packet 
purpose, you may go directly to Packet and make your selection. 

• Packet – use the dropdown arrow to select the packet to copy into. 
 

 
 

5. Once you’ve made your selections click the Copy button and a message will appear warning 
you of the action that will be taken. 
 

6. If this is the action you intended click the OK button. 
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7. A message will appear saying that the action was completed. 
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Lesson 6, Task 2  – Copy Coding Structure 
 
Copy coding structure means to copy the selected coding structure contained in one packet to another 
coding structure within the same packet.  You may select to copy the coding structure with or without 
the allotment details. 
 

1. From View Packet List choose a packet and click the Allotments tab.  Then select the coding 
structure you wish to copy and click the Copy tab.   Note:  Only one coding structure can be 
copied at a time   
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In the Copy tab you make your selections. 

 
• Include – is used to include all allotment details or deselect the items not needed. 
• What Action to take - choose between Merge/Sum Amounts Together for Duplicates and 

Delete Original/Replace. 
• To Packet – is used to designate what coding structure you want the data being copied to 

go to. 
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2. Select what action you’d like to take: 
 

• Merge/Sum Amounts Together for Duplicates – this action will add allotment details 
that do not exist in the ‘to’ packet coding structure and where there are duplicate coding 
elements it will add the amounts together. 

• Delete Original/Replace – this action will delete everything in the ‘to’ packet coding 
structure and only bring in the selected items.  
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3. Select which coding structure to copy to: 

 
• New Coding Structure – use the dropdown arrow to select a new coding structure.   
• Existing Coding Structures – use the dropdown arrow to select the coding structure 

you wish to copy to.   
 
 Note:  Biennium, Packet Purpose, and Packet are not options at this time and are 
grayed out. 
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4. Once you’ve made your selections click the Copy button. If you selected an existing coding 

structure, a message will appear warning you of the action that will be taken. 
 

5. If this is the action you intended click the OK button. 
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6. If you selected New Coding Structure another dialog box will appear.  This dialog box will 
show the coding structure you are copying from.  Enter your new coding structure and click 
Save. 
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7. A message will appear saying that the action was completed. 
 

 
 
 
TO DO - Hands on:  Practice copying packets, copying coding structures to new coding 
structures and existing coding structures. 
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LESSON 7 – FEATURES NOT INCLUDED IN INITIAL & INTERNAL 

PACKET PREPARATION 
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Lesson 7, Task 1 – Adjustment Amount 
 
 Note: The adjustment amount field was created to allow agencies to move allotment capacity from 
closed fiscal months without skewing the current month or changing the official allotment record for 
closed months.  The total adjustment from closed months can be placed into the adjustment month field 
and the current month amount will contain the actual change desired for that month.  The adjustment 
amount will show as a separate entry on the TALS-AMR reports.  The adjustment amount will however 
be posted to AFRS in the current fiscal month. 
 

1. Create a new packet with packet purpose        

Operating 2nd Qtr Adjustments                                              
2. Add a new coding structure and allotment details.  Notice that a new amount tab is available 

(Adj. Amount).  See below: 

 

 
 
 

3. After choosing an EAI and Object put a negative dollar amount in Adj. Amount and spread 
that amount in open months, then click Save and Cancel.   
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4. You have created an adjustment allotment.  See below: 
 
 
Adjustment Amount 
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 Lesson 7, Task 2 – Moving Unallotted Funds into Allotted   
 

1. Create a quarterly adjustment packet. 

2. Expand the UnAllotted Allotment Details grid, choose the Add tab, choose an EAI, then put 
in a negative dollar amount, click Save and Cancel.   

3. Now take that amount and allot it in open months. 

4. Go to the Expenditure Allotment Details grid and expand it, click the Add tab and choose 
an EAI and Object, and put the amount in. 

5. You have successfully moved unallotted funds into allotted. 
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Lesson 7, Task 3 – Unanticipated Receipt (UAR) 
 
 Note:  The unanticipated receipt (UAR) packet purpose requires that you use the unanticipated 
receipt form from within the application.  This keeps all documentation of the UAR in one location. 
 

1. Create an unanticipated receipt packet by choosing 2011-2013 Biennium, Purpose “Operating 
Unanticipated Receipts” and choosing a contact.  After you click Save you will see a new tab 
available “UAR.”   

 

 
2. Click on the UAR tab. This is how you get to the Unanticipated Receipt Approval Request 

form.  Fill in the following: 
Contact Person: Your Name 
Phone Number: Your Phone 
Purpose of grant…:  UAR Training Grant 
Begin Date: Today’s Date 
End Date:  One year from today 
Type of Grant: Choose “new” 
Budget Impact Summary Grant Award: $10,000, no matching funds 
Analysis:  Choose “no” on all of them 

3. Click Ok. 
4. Click on the Allotments tab and set up a coding structure and allotment detail for the $10,000 

award.  Note:  When establishing an UAR you must set up an Appropriation Index through 
the AFRS tables as described in the Allotment Instructions and the State Administrative and 
Accounting Manual (SAAM) with at least one of them having an appropriation type of a 3 or 9.  
This information must be in the AFRS tables before you submit your UAR or it will not pass the 
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pre-release edits.  Note:  For capital UAR packets, you must establish your coding in AFRS 
prior to creating the allotment in order for the capital project number to be editable in the 
system.    Note:  All UAR packets must include an attachment of the grant award. 
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• Packet Number—Will be derived from the packet and will also display the packet title. 

• Date Submitted—Will automatically fill in once the packet is submitted with that date. 

• Agency Code & Title—Will be derived from the packet. 

• Contact Person—A required text field. 

• Phone Number—A required text field for the contact person’s phone number. 

• Program Code & Title—A drop down field the user can choose for the appropriate program.  It is an 
optional field. 

• Budget Activity Code & Title—Two text fields that are optional. 

• Operating/Capital—This field is derived from the packet type. 

• Purpose of Grant and Description of How Funds will be Used—A required text field. 

• Time Period for this Grant Award—The begin and end dates are two required date fields. 

• Type of Grant/Award—Four choices of new, renewal, addendum, or carry over from the previous 
biennium.  One of these must be chosen. If carry over from previous biennium is chosen, you must 
indicate the previous packet number. 

• Pass-Through Only—an optional check box.  If this is selected, an explanation must be given. 

• Budget Impact Summary—This table captures FTEs, grant/award and matching fund information for 
previous, current and ensuing biennia as well as current allotment request and amount agency expect to 
request in the next budget submittal.  The details are described in the following table: 

 Account EA 
Type 

Previous 
Biennium 

Current 
Biennium 

Ensuing 
Biennium 

Current 
Allotment 
Request 

Amount Agency 
Expects to 
Request in Next 
Budget Submittal 

FTEs N/A N/A FTE 
amount 
field / 
optional 

FTE 
amount 
field / 
optional 

FTE 
amount 
field / 
optional 

FTE 
amount 
field / 
optional 

FTE amount field / 
optional 

Grant/Award derived 
from 
packet 

derived 
from 
packet 

dollar 
amount 
field / 
optional 

dollar 
amount 
field / 
required 

dollar 
amount 
field / 
optional 

derived 
from packet 
based on 
account/ 
EA type 

dollar amount field / 
optional 

Matching 
Funds 

combo 
field / 

combo 
field / 

dollar 
amount 

dollar 
amount 

dollar 
amount 

dollar 
amount 

dollar amount field / 
optional 
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optional optional field / 
optional 

field / 
optional 

field / 
optional 

field / 
optional 

Total Dollars N/A N/A calculated 
sum of 
dollar 
amounts 
above 

calculated 
sum of 
dollar 
amounts 
above 

calculated 
sum of 
dollar 
amounts 
above 

calculated 
sum of 
dollar 
amounts 
above 

calculated sum of 
dollar amounts above 

   

• Does the Grant Require Matching Funds?—Must choose yes or no, if yes is chosen, you must indicate 
the source of matching funds and programs and activities that will be affected by using these funds. 

• Analysis section—A series of four questions, the first three of which a choice of yes or no must be 
selected, the last question is optional.  In the first question “Can these funds be substituted for 
presently allotted funds?” If yes is selected, at least one matching reserve allotment detail record must 
exist in the packet before it can be submitted.  If no is selected and the reason is anything other than a 
specific stipulation by the grantor, it must be explained.  In the second question “Does acceptance of 
these funds commit the state to further expenditures in a later period?” If yes is selected, then the 
probable source of future funding must be explained.   
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LESSON 8 – EXPORT 
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Lesson 8, Task 1 –  Export/Import Coding Structure & Allotment Data  
 
Agencies may want to make changes to an existing allotment packet.  The Export tool can be used to 
export allotment data, make modification and then import back into TALS-AMR. 
 
 Note:  Can export only one packet at a time.    Note:  Will export allotment data into a tab 
delimited text file.    Note:  If modifications are needed, it is best to save the export text file into 
Excel, make your changes, save back to a tab delimited text file and then import back into TALS-AMR.   
 

1. From the View Packet screen, select the allotment packet that you want to export, then the 
Export tab.  Make sure to select an allotment packet that has allotment data.  The Export Data 
dialog box will be displayed: 

 

 
 

2. All data elements are selected by default when the Export Data dialog box opens.  Select the 
Export button.  The File Download – Security Warning dialog box will display: 

 
 Note: You can deselect the appropriate selections by clicking the check boxes.   
 

 
 

3. Select Save to save this file. 
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4. You will be prompted to confirm the save location of the export file.  In training, choose the 
Desktop icon.  The system will generate a file name with the packet number and date (i.e. 
TALSExport_0019_2282007.txt).  You can decide to change the file name or leave the file 
name as is.  In training leave the file name as is. 

 Change the Save as Type to:  All Files 

 Select Save. 

 

 
 

 
 
 

5. A Download Complete dialog box will be displayed.  Select Close.  The packet has been 
exported into a tab delimited text file. 
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6. To make modification to exported allotments you will want to make your changes in Excel.  
You have a couple of options.  One option is to open the exported text file and copy and paste 
into the Excel Import Template.  The other option and in training perform the following.  
Open Excel, change “Files of type” to Text Files, browse until you find the exported text file, 
double click on the text file.   Note:   When you want to modify the text file, it is best to 
make changes in an Excel file rather than in the text file (the reason is because columns do not 
line up with the headings in a text file).   

 

 
 
 
 
 

7. The Text Import Wizard – Step 1 of 3, dialog box will open.  Select “Delimited” data type.  
Then select “Next>”. 
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8.  The Text Import Wizard – Step 2 of 3 dialog box will open.  Select “Tab” (Tab is        selected 

by default), then select next. 
 

 
 
 

 
9.  The Text Import Wizard Step 3 of 3 will open.  Highlight all the coding columns by holding 

down the shift key, do not highlight the Amounts columns.  Then Select “Text” for the 
Column data format.    You do not want to make the Amounts columns text in case you want 
to use formulas or links to other spreadsheets.  Select the Finish button. 
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10. Now your Exported text file will open in Excel, however the file extension is .txt.  After your 

file is open, highlight the coding columns, select Format, select Cells, select Text and then 
select OK.  The coding columns are formatted to text; this will ensure your codes with leading 
zeros will not be lost. 

 
 Note:   In the diagram below, notice the file opens in Excel and has a file extension of .txt. 
 

 
 

11. Freeze the column headings by clicking in spreadsheet cell A2.  Selecting Windows from          
the tool bar and then select Freeze Panes.  

 
12. Add a row of coding for your agency with amounts for each of the following allotment types:  

Expenditure, FTE, Reserve, Unallotted, Revenue, Cash Disbursement, and Cash Receipt.   
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 Note: Allotment Type Code for the following:  (see appendix 3 for the Import Specification)  
 Note:  Option 1 agencies must have a separate row for expenditure EA Indexes and 
Objects.   
  
Expenditure = EXP 

 FTE = FTE 
 Reserves = RES 
 Unallotted = UNA 
 Cash disbursement = CAD 
 Revenue = REV 
 Cash receipt = CAR 
 
     13.  Save this file as a text, tab delimited file:  
 

Select File, Save As, click the Desktop icon, and  
change the File Name:  Agency XXX Export X.txt 
Save as Type:  Text (Tab delimited) (*.txt) 
Select Save. 
 

 
 
 
14.  You will be prompted with the following message.  Select OK. 
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15.  You will be prompted with the following message.  Select Yes. 
 

 
 
16.  The text file has been saved.  Import this text file back into the packet that was exported in this 

lesson.  The next lesson will walk you through importing the text file. 
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LESSON 9 – IMPORT TEXT FILE 
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Lesson 9, Task 1 – Download the Import Template  
 
The Import tool gives agencies the ability to import data from agency internal allotment systems or 
from Excel spreadsheets.  The Excel template that you are about to download is the format that is 
required to import allotment data into the application.   
 
 Note:  The template format is in the required Import format.  Do not add, delete or rearrange 
columns.   Note:  It will be the agency’s responsibility to ensure that the import file is in the proper 
format and the fields within the file meet the prescribed format (see appendix 3 for the Import 
Specification).    
 

1. From the View Packet screen, add a new packet.  In the packet title enter Import Packet.  
 

2. Select the new packet and then select the Import tab.  The following dialog box will display: 
 

 
 

3. Select the Click here to download the file upload template link.  A File Download dialog 
box will be displayed.  Select Open. 
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4. The AMR Import template will open.   

 

 
 

5. Select Save As and save this template as an Excel file.  In training, save to your Desktop. 
 

 
 
The import template is now ready for you to create your allotments to import into TALS-AMR.  See 
appendix 3 for Import specification. 
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Lesson 9, Task 2 – Import Text File 
 
Once you have created your allotment data in the proper import format and saved as a text file, you can 
now import into TALS-AMR.   
 
 Note:  The packet into which the data will be imported must exist prior to selecting the Import tab.  
 Note:  Data can be imported into a packet in draft or returned status only.  Note:  Can merge 
together a text file into an existing packet that already has data.   Note:  When the Merge/Sum 
Amounts Together for Duplicates radio button is selected, the import will merge all new coding 
structure and allotment detail data, for all components.  When there are duplicate coding structures 
and allotment details, the amounts will be summed together.   Note:  When the Delete 
Original/Replace radio button is selected, the import will replace all Coding Structure and Allotment 
Detail data for all components.    Note:   If there are import errors, the text file will not import into 
the application.     Note:  Imported files cannot be larger than 3MB.   
 
 Note: If you perform an import for both the SPS Import and the text file import, you should import 
the text file first then the SPS Import.  The reason the import should be performed in this order is 
because the Import Text File replaces or merges all data and the SPS Import only replaces or merges 
FTE, and expenditure object A and B data.  See the Import SPS Data lesson for more information. 
 

1. From the View Packet List, select the allotment packet you wish to import into.  Then select the 
Import tab. 
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2. Select the Text File tab. 
 

 
 

3.  Select the Browse button, search for the text file you updated in the prior lesson.  To import, 
double click the file for import.   

 Note: The file must be a text file. 
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4. After selecting the File, the File location and name will appear to the left of the Browse button 
on the Import dialogue box.   Select the Delete Original/Replace radio button. 

 
 Note: By selecting the Delete Original/Replace radio button, this import will delete and replace 
all data in the selected packet. 
 Note:  By selecting the Merge/Sum Amounts Together for Duplicates, it will merge all new data 
and sum duplicate data amounts together, but will not delete data previously in the packet before 
the import.  This functionality would be used when you want to merge a text file into a packet that 
already has data. 

 
 

 
 

5. Select the Upload Button.  The system will display a warning message about deleting existing 
data, click OK.        
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6. On completion of the Text File Import, the system will display a successful message, click OK. 
 

 
 

 Note:  For an unsuccessful import you will receive a Text Import Error Report.   See 
Appendix 3 for the required import format.  The errors must be corrected before the import will 
upload successfully.  It is best to make your corrections in Excel rather than in the text file.   
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LESSON 10 – IMPORT SPS DATA 
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Lesson 10, Task 1 – Import SPS Data 
 
Agencies can create SPS Projection files that can be used to import allotment data for FTEs and 
expenditures for objects A and B.   
 
 Note:   The packet into which the data will be imported must exist prior to selecting the import tab.  
 Note:  Data can be imported into any packet in a status of draft or returned.     Note:  An SPS 
Projection file can be imported into a packet that has existing data.    Note:  When the Merge/Sum 
Amounts Together for Duplicates radio button is selected, this import will merge any new data into the 
selected packet for FTEs and expenditure objects A and B only.  If there is duplicate data with the 
same coding structure and allotment detail for FTEs and expenditure objects A and B, the amounts 
will be summed together.   Note:  When the Delete Original/Replace radio button is selected, this 
import will delete and replace any data in the selected packet for FTEs and expenditure objects A and 
B only.  If importing both the Text File and SPS Data, import the Text File first and then the SPS Data.  
 Note:   For Option 1 agencies, allotment details with an EA index will not be deleted, but will have 
their EA index amounts added to any new amounts from SPS.  
 

1. From the View Packet List screen, select the allotment packet, then the Import tab. 
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2. Select the SPS Data tab. 
 

 
 

3. Click the down arrow for the Projection File.  Select the Projection File to be imported. 
 
 Note: The Projection File list only includes projection files for the specific biennium of the 
selected packet. 
 Note:  Both program index and EA index must exist in the SPS Projection File for the SPS 
data to be imported into TALS-AMR. 
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4. Click the down arrow for Salary & Benefit Rollup to select the level of detail to be imported.  
Select Object. 
 
 Note:  The Salary & Benefit Rollup is referring to Expenditure Allotment Details EAI and 
not FTE. 

 

 
 

5. Click the down arrow for FTE Account Rollup to select the FTE detail level at account or EAI.  
Select 001/996 Account. 
 

 Note:  By selecting 001/996 Account, the FTEs that are 001-1 (GFS) will be imported as 001 
and all other FTEs will be imported as 996.  If you have 001-2 (GF), this will be imported as 996. 
 Note:  By selecting Account, the FTEs will be imported by account.  Note:  By selecting EAI, 
the FTEs will be imported by EAI. 
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6. Click the down arrow for FTE Object Rollup to select the FTE object level.  Select No Object. 
 

 Note:  By selecting No Object, FTEs will be imported with no object 
 Note:  By selecting Object, FTEs will be imported at the object level 
 Note:  By selecting Sub-Object, FTEs will be imported at the sub-object level 
 Note:  By selecting Sub Sub-Object, FTEs will be imported at the sub sub-object level 
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7. Select the Delete Original/Replace radio button. 
 

 
 
 Note: By selecting the Delete Original/Replace radio button, this import will delete and replace 
any data in the selected packet for FTEs and expenditure object A and B only. 
 Note:  By selecting the Merge/Sum Amounts Together for Duplicates radio button, this import will 
merge any new data into the selected packet for FTEs and expenditure object A and B only.  Plus, if 
there is duplicate data (same coding structure and allotment detail for FTEs and expenditure object A 
and B only) the amounts will be summed together. 
 

8. Select the Import button, the system will display a warning message, click OK. 
 

 
 

 
9. On completion of the SPS import, the system will display a successful message, click OK. 

 
 Note:  Option 2 agencies will receive the following message, select OK. 
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 Note:  Option 1 agencies will receive the following message, select OK. 
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LESSON 11 – ONLINE VIEWS 
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Lesson 11, Task 1 – Using Online Views 
 
Online Views allows you to view allotment data for analytical purposes.  Online Views enables you: 

 To specify the specific data you want to view by way of creating a query—called a “filter” in 
the system.  The filter contains 4 tabs: 

1. Packet – choice of component for either expenditures, cash disbursements, cash receipts, 
and revenue information.  Contains selections for packet number, purpose, status, packet 
program, and title. 

2. Organization – contains coding structure information for program, organization, and project 

3. Account – contains expenditure authority, account, and object choices 

4. Summary – lists the filter summary 

 To organize the data requested in a hierarchy of your choice.  This is done by the grouping 
level selected in the filter tab.  You may select up to 4 grouping levels, 1 grouping level must 
be selected.   

 To quickly view the amounts requested at a summary level as well as the detailed data 
contributing to that summary.   By grouping and displaying you are able to drill down to the 
data as needed from your filter. 

  Note: Online Views are not intended for printing.  The AMR reports through Enterprise Reporting 
can be used for printing allotment data.  See Lesson 15. 

 

 Note: Online Views behaves differently depending on the Option of your agency.  Since Option 1 
agencies enter their expenditure data by Object and EAI separately they will also view that data 
separately. 
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ONLINE VIEW for OPTION 1 AGENCY 

If you are an Option 2 agency,  
skip to the Option 2 agency section of this lesson. 

 
Since an option 1 agency enters expenditure data by Object and EAI separately, they need to view 
the data separately as well.   Note:   If no criteria is selected for either Object or EAI on the 
Account tab, Expenditures by Account or EAI will display by default.  If Object criteria is selected 
on the account tab, but no EAI criteria, then only the Expenditures by Object will display.  If both 
Object and EAI criteria (leave the EAI Criteria field blank, however, select Group Lvl. and check 
Disp.) are selected on the account tab then both grids will be displayed.   

 
Below you will see a sample online view for Program, Account, EAI, and object detail in 3 packets 
for an Option 1 agency.  Following will be the steps that show you how to create this display.   
Group level 1 is Packet Number, group level 2 is Program, group level 3 is Account, and group 
level 4 is EAI and Object, and displaying packet number, program, account, EAI, and object.   
 
 

 
 
 
Now we will see how to create this online view step by step: 

 
1. Select the Online Views option from the application tab bar, next to the View Packet List button. 

2. The ‘No filter has been defined for the Online View’ message will prompt you to create a filter.   
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3. Select the Filter tab.  The following dialog box will be displayed: 

 

 
 

 Note:   The Filter tab allows you to specify the data and level of detail you want to see and how 
that data should be displayed to you on the screen.  The filter contains 4 tabs: 

• Packet – choice of expenditure, cash disbursement, cash receipt, and revenue component 
information.  Contains selections for packet number, purpose, status, program, and title.  
You also have the choice of viewing expenditures, staff months, unallotted, and reserves 
within the expenditures components. 

• Organization – contains coding structure information for program, organization, and 
project 

• Account – contains expenditure authority, account, and object choices 
• Summary – lists the filter summary 
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4. From the Packet tab first select the Expenditures Component.  
  

 
 
5. When Expenditures is selected, you may select to display Expenditures, Staff months, Unallotted 

and Reserves.  For this example we will only select Expenditures.    
 
 Note: Any one or all may be selected.   Note:  Grouping and Displaying data – you will have the 
ability to create hierarchies of data by selecting to display elements at a particular group level by 
using the Group Lvl. combo box.  Up to 4 group levels may be selected.   Each group level is displayed 
in the online view as a summary row with a “+” to expand the rows that contribute to that rollup.  If 
the element is to be displayed in the online view the Disp. box must be checked.  You may specify 
criteria to filter on or leave blank to return all data.  Note: A Group Lvl. must be chosen if a 
criterion is entered.   Note: At least one element must be selected to display. 
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6. Select Group Lvl 1 and check Display for packet number and enter three packet numbers in the 
Criteria box. 
 

 
 
 Note:   You may narrow your filter by defining the criteria you wish to view.  The Criteria may 
be entered manually into the criteria box or click on the “…” for a list and make your selections 
from the list.  You may enter criteria up to 255 characters.  A blank criteria box means all data will 
be returned. 
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7. From the Organization tab, select Group Lvl 2 for Program and check display Program.   
Note:   You can select the ‘-’ to close expandable fields for Program, Org. and Project. 
 

 
 
 Note:   The criteria for these coding elements are entered in the text box next to its associated 
coding level, or can be selected from the lookup dialog.  You may enter a single criterion or 
multiple criteria elements by separating them with a comma.   Note: Click on the ‘…’ at the 
right of the text box for the lookup dialog. 
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8. From the Account tab select to group and display the Account (Group Lvl 3), EAI, and Object 

(Group Lvl 4).  As stated above for Option 1 agencies, in order for both EAI and Object to appear 
in online views you must select to display both.  
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9. The Summary tab will display the filter criteria you have selected after the Refresh button has 
been pressed.  See below. 
 

 
 
10.   When all your selections have been made, press the OK button. 
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11. The data can now be expanded and collapsed as needed.  Expand where there is a ‘+’ and collapse 
where there is a ‘-‘.  When the data has been expanded, it will remain expanded throughout the 
session, as long as a new filter is not created.  You also have the option to select the Expand Rows 
tab; this will expand all rows down to the magnifying glass.  When you want to collapse all rows, 
select the Collapse Rows tab. 
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12. Updating data from Online Views – the magnifying glass icon indicates the lowest grouping level 
of data has been reached.  When the magnifying glass has been clicked you will then go to the 
Packet, Coding Structure and Allotment Detail information where you may select an item to update 
or delete.  The Coding Structure and Allotment Detail rows will have check boxes to allow the 
selection of those records to open for updating, or for deleting.   Note: When delete is selected a 
confirmation dialog box will appear. 
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13. When updating a record the dialog box appears with the data as originally entered, you may make 

any changes and Save.   Note: After you save the dialog box will reappear with the update.  
Click cancel to close the dialog box.  You will return to the previously expanded Online View.  If 
one of your sort criteria is something you change as an update or delete, the filter will re-run and 
may not display any information. 
 

 
 
14. When you are finished with this view and would like to select a new filter just click the Filter tab.  

The previous filter will be populated as previously defined.  You may modify the filter or click 
Clear to start over. 
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ONLINE VIEW FOR OPTION 2 AGENCY 
If your agency is an Option 1 agency,  

skip to the Option 1 agency section of this lesson. 
 
Below you will see a sample online view for Program, Account, EAI, and object detail in 3 packets for 
an Option 2 agency.  Following will be the steps that show you how to create this display.   Group 
level 1 is Packet Number, group level 2 is Program, group level 3 is Account, and group level 4 is EAI 
and Object.  This will display packet number, program, account, EAI, and object.   

 
 

 
 
Now we will see how to create this online view step by step: 

 
1. Select the Online Views option from the application tab bar, next to the View Packet List 

button. 

2. The ‘No filter has been defined for the Online View’ message will prompt you to create a filter.   
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3. Select the Filter tab.  The following dialog box will be displayed: 
 

 
 
 Note:   The Filter tab allows you to specify the data and level of detail you want to see and how 
that data should be displayed to you on the screen.  The filter contains 4 tabs: 

• Packet – choice of expenditure, cash disbursement, cash receipt, and revenue component 
information.  Contains selections for packet number, purpose, status, program, and title.  
You also have the choice of viewing expenditures, staff months, unallotted, and reserves 
within the expenditures components. 

• Organization – contains coding structure information for program, organization, and 
project 

• Account – contains expenditure authority, account, and object choices 
• Summary – lists the filter summary 
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4. From the Packet tab first select the Expenditures Component.   
 

 
 

5. When Expenditures is selected, you may select to display Expenditures, Staff months, 
Unallotted and Reserves.  For this example we will only select Expenditures.    Note: Any 
one or all may be selected.   

 
 Note:  Grouping and Displaying data – you will have the ability to create hierarchies of data by 
selecting to display elements at a particular group level by using the Group Lvl. combo box.  Up to 
4 group levels may be selected.   Each group level is displayed in the online view as a summary 
row with a “+” to expand the rows that contribute to that rollup.  If the element is to be displayed 
in the online view the Disp. box must be checked.  You may specify criteria to filter on or leave 
blank to return all data.  Note: A Group Lvl. must be chosen if a criterion is entered.   Note: 
At least one element must be selected to display. 
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6. Select Group Lvl 1 and check Display for packet number and enter three packet numbers in 

the Criteria box. 
 

 
 
 Note:   You may narrow your filter by defining the criteria you wish to view.  The Criteria may 
be entered manually into the criteria box or click on the “…” for a list and make your selections 
from the list.  You may enter criteria up to 255 characters.  A blank criteria box means all data will 
be returned. 
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7. From the Organization tab, select the ‘+’ next to Program, select Group Lvl 2 and check 
display Program.   Note:   You can select the ‘-’ to close expandable fields for Program, 
Org. and Project. 

 

 
 
 Note:   The criteria for these coding elements are entered in the text box next to its associated 
coding level, or can be selected from the lookup dialog.  You may enter a single criterion or 
multiple criteria elements by separating them with a comma.   Note: Click on the ‘…’ at the left 
of the text box for the lookup dialog. 
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8. From the Account tab select to group and display the Account (Group Lvl 3), EAI, and 
Object (Group Lvl 4). 
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9. The Summary tab will display the filter criteria you have selected after the Refresh button has 
been pressed. 

 

 
 

10.   When all of your selections have been made, press the OK button. 
 
11. The data can now be expanded and collapsed as needed.  Expand where there is a ‘+’ and 

collapse where there is a ‘-‘.  When the data has been expanded, it will remain expanded 
throughout the session, as long as a new filter is not created.  You also have the option to select 
the Expand Rows tab; this will expand all rows down to the magnifying glass.  When you want 
to collapse all rows, select the Collapse Rows tab. 
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12. Updating data from Online Views – the magnifying glass icon indicates the lowest grouping 
level of data has been reached.  When the magnifying glass has been clicked you will then go 
to the Packet, Coding Structure and Allotment Detail information where you may select an item 
to update or delete.  The Coding Structure and Allotment Detail rows will have check boxes to 
allow the selection of those records to open for updating, or for deleting.   Note: When delete 
is selected a confirmation dialog box will appear. 
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13. When updating a record the dialog box appears with the data as originally entered, you may 
make any changes and Save.   Note: After you save the dialog box will reappear with the 
update.  Click cancel to close the dialog box.  You will return to the previously expanded 
Online View.  If one of your sort criteria is something you change as an update or delete, the 
filter will re-run and may not display any information. 

 

 
 
 

14. When you are finished with this view and would like to select a new filter just click the Filter 
tab.  The previous filter will be populated as previously defined.  You may modify the filter or 
click Clear to start over. 
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TO DO – Hands on:  Here are 3 suggested online views for you to create 
 
To see what packets have affected a certain PI by EAI.  The following steps will show how to create 
that online view: 
 

1. Organization tab selection:  Pgm. Idx. = Group Lvl. 1, check Disp., and enter a PI in the criteria 
box. 

2. Account tab selection:  EA Idx. = Group Lvl. 2, check Disp. 
3. Packet tab selection:  Component = Expenditures.  Number = Group Lvl. 3, check Disp. 
4. Click OK for online view 
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To see all data pertaining to one account by PI.  The following steps will show how to create that 
online view: 
 

1. Account tab selection:  Account = Group Lvl. 1, check Disp., and enter a 3 digit account 
number in the criteria box. 

2. Organization tab selection:  Pgm. Idx. = Group Lvl. 2, check Disp. 
3. Packet tab selection:  Component = Expenditures and Staff Months.  Number = Group Lvl. 3, 

check Disp. 
4. Click OK for online view 
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To see all revenue data in one packet by major source and source.  The following steps will show how 
to create that online view: 
 

1. Packet tab selection:  Component = Revenue.  Number = Group Lvl. 1, check Disp., and enter a 
4 digit packet number in the criteria box. 

2. Account tab selection:  Account = Group Lvl. 2, check Disp., for Rev. Src. Click the ‘+’ and 
enter Group Lvl. 3, check Disp., Source = Group Lvl. 4, check Disp. 

3. Click OK for online view 
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Lesson 11, Task 2 – Saving a Filter 
 
Filters in Online Views can be saved using the Save Filter function on the Online Views screen.  
Previously saved filters can be viewed by using the Open Filter function. 
 

1. To save a filter, first create a filter in Online Views.  Once you hit Ok for the filter and the data 
is displayed select the Save Filter tab and the following dialog box appears.  Give the filter a 
Title and press the Ok button.  Your filter is now saved.   
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2. To open a saved filter, first select the Open Filter tab and the following dialog box appears.  
Select the saved filter and press the Ok button and your saved filter will appear.  

 

 
 

 
 

3. To update a saved filter, first select the Open Filter tab, then select the saved filter you wish to 
update and press the Ok button and your saved filter will appear.  Then select the Filter tab to 
make your changes and click Ok. 

 
 
 
 
 
 
 
 
 
 
 
 



 

 125 

4. Then select the original filter from the Save Filter tab and click Update.  This will update the 
saved filter with the changes just made. 
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5. To update a saved filter and save it as another filter, first select the Open Filter tab and select 

the saved filter you wish to update and press the Ok button and your saved filter will appear.  
Click the Filter tab to bring up the filter criteria.  Make your changes and click Save Filter, 
then give it a new title and click Save.  You now have a new filter. 

 

 
 
 
Lesson 11, Task 3 –  Opening Online View Filters 
 
Online Views previously Saved by other users can also be viewed. 
 

1. After selecting Open Filter, use the dropdown arrow to select another user and a list of their 
saved filters will appear.  Select a filter and click OK. 
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You may also update another users saved filter and save it as your own. 
 

2. When another users filter is displayed select Save Filter, give the filter a title and click Save. 
 

 
 
Note:  The filter will also be saved under your name. 
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TO DO - Hands on:  Practice saving and opening filters.   
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LESSON 12 – REVIEW ISSUES 
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Lesson 12, Task 1 –  Creating and Responding to Review Issues 
 
 
Review Issues is the part of the system that facilitates communication between OFM budget analysts 
and agency analysts as errors, problems, or concerns arise, or just when further clarification is needed.  
It provides a means where either the OFM budget analyst or the agency analyst can create issues about 
a packet and carry on a threaded conversation about an issue, to include attachments and online view 
links as necessary. 
 

1. Go to View Packet List and choose a packet and click the Review Issues tab.   Note:  Issues 
and responses can only be added to packets in review and returned status.  Issues and 
responses can be viewed, but not changed in packets with approved status. 
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In the Review Issues tab you may add an issue or response. 

 
• Add Issue – is used to add a new issue. 
• Add Response – is where you would respond to an existing issue. 

 

 
 

2. To add an issue Select the Add Issue tab and the following dialog box will appear: 
  

 
 

3. Describe the issue in the body of the dialog box. 
 
4. Give the issue a title that easily identifies it.   Note:  The title is displayed on the review 

issues screen.  The body of the issue can only be seen when you expand the issue by selecting 
the “+”. 
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5. Select who you want notified in the E-Mail Notify box.   Note:   For a dropdown list select 

the “…”. 
 
6. To add an Online View Link to your new issue, click the Attachments and Links tab.  Your 

previously saved Online Views will be displayed in the Stored Filters box.  You may choose 
one or more Stored Filters to be displayed along with your Issue.  Simply highlight your 
selection and click the right-handed directional arrow to move the items to the Selected Links 
box.   Note:  you can remove Online Views links from the Selected Links box by highlighting 
the link and clicking on the left-handed directional arrow. 

 
7. To add an Attachment, click the Attachments and Links tab.  Select the Browse button to 

locate the file, click the Add button.   Note:  You have the option to specify an Attachment 
Title.  If an Attachment Title is not entered, it will default to the File name.    Note: 
Attachments can be Word, Excel, or PDF formats, and are limited in size to 3MB. 

 

 
 
 
 
 
 
 
 
 
 
 
 

 



 

 133 

8. When finished select the Save button. 
 

The following screen shot details the fields available from Review Issues: 
 

 
 

1. A blank check box related to issue number 1.  To add a response to the issue, you must check 
here and click the Add Response tab. 

2. Issue title. 
3. Body/Description of issue number 2 (only displayed when expand the issue). 
4. Response to issue number 2 (each additional response will be listed in order of response). 
5. From tells you who generated the issue or response. 
6. Message displays the written body/description of the issue or response. 
7. Attachments will show as a link (it will display the title given or default to the file name if no 

title is given). 
8. Links will show as a link if online view links were chosen. 
9. Date displays the date and time the issue or response was created. 
10. Resolved will show a check mark once your OFM budget analyst has considered and checked 

off the issue as resolved. 
11. Date created is the original date the issue was created. 
12. Last Update shows the last date of an issue/response related to the issue. 
13. Issue number 1.
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Lesson 12, Task 2 –  Responding to an Issue 
 

1. To respond to an issue select an issue and the Add Response tab and the following dialog box 
will appear: 

 

 
 
 
Enter your response.  You may also add attachments and links by selecting the Attachments and 
Links tab.  This is the same dialog box that is used in the previous lesson when adding an issue.  When 
finished select the Save button.  
 
TO DO - Hands on:  Practice adding Issues and attachment 
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LESSON 13 – PRE-RELEASE EDIT CHECK 
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Lesson 13, Task 1 –  AMR Pre-release Edit Checks 
 
TALS- AMR has a full range of edit checks that ensures the allotment meets all required standards and 
alerts agencies to other anomalies that may warrant a note to OFM.  For many of the edits resulting in 
errors, the edit check will provide the user with a link to the data elements that are causing the error to 
facilitate review and corrections.  From the View Packet List you can run the AMR Pre-Release Edit 
Report, which is located in the upper right hand corner of the screen. 
 
 Note:   You can select one or more packets to run the AMR Pre-Release Edits.   Note:   There 
are three types of edits; critical, warnings and informational edits.  A number of the warning errors 
will prompt the user to provide an explanation in the packet for OFM about a particular pattern or 
condition in the allotments.  OFM will be able to see these warning messages as well and will be 
looking for those comments.  Your packet may be returned if the requested information is not provided.   
 
 Note:  There are a couple of edit checks that compares allotments to actuals.  This edit check is 
only performed on an Operating Initial packet purpose type when the Operating Initial packet 
allotments deviate more than 10% from the historical actuals.  When allotments deviate more than 
10%, a warning message will display on the AMR Pre-Release report.  Also included in this warning 
message is a link to a chart that will display the comparison.     
 

1. Select a packet or packets from the View Packet List screen.  In the right hand corner of the 
screen, select AMR Pre-Release Edits in the drop down, then select Run. 

 
AMR Pre-Release Edits 

 

 
 
 

2. The AMR Edit Report will open if there are errors.  The following items are viewable on this 
report: 
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1. Agency—displays Agency number and name 
2. Biennium—displays biennium your packets are associated with 
3. Date and Time—displays current date & time report was ran 
4. Packet(s)—displays packet number(s) 
5. Edit Level:  Critical, Warning and Informational—displays all errors in sections in this 

order 
6. Type—AMR or AFRS 
7. Edit #--displays number, see Appendix 4 for complete listing of errors 
8. Description—displays written information to the nature of the error 
9. Where—Links to Online Views to take you to the error   Note:  The system won’t 

always provide a link depending on the type of error produced 
10. Print—allows you to print the report 
11. Cancel—takes you back to the view packet list 
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3. Select the Online Views link—the link in the Where column.   Note: Online views will 

appear behind the AMR edit report so you can minimize or cancel the report (recommend 
minimizing if more than one error) or click on the online views in the background and the error 
report will automatically be minimized.   

 

 
 
  Note:  Selecting the online views link from the AMR Edit Report will take you to the data that 
caused the error in online views.  To fix the error you must evaluate if the change needed is to the 
allotment information or if another action must be taken.  For example, if the error says “the program 
index XXXXX does not exist in AFRS“, the fix may be setting it up in AFRS not changing it in TALS 
AMR.   
 
 Note:  Going to online views through the AMR Pre-Release edit takes you to the data that caused 
the error only.  However, when coming to online views through AMR Pre-Release Edits, you do not 
have the option to change your online views filter.  
 

4. Try fixing an error:  Select the magnifying glass and expand the grid to the level of detail where 
the error occurs.  Select the coding structure check box and click Update.  Change the amount 
and select Save, and then Cancel to close Update dialog box.   

 
 Note:  For more information regarding the edits, see appendix 4 – Pre-Release Edits, which 
identifies the Edit #, Edit Type (Critical, Warning or Informational), and Description (and in some 
cases gives more detail about the edit than the Pre-Release Edit report does).  
 

5. Select the View Packet List breadcrumb at the top of the screen to return to the View Packet 
List screen. 

 
TO DO – Hands on:  Practice correcting pre-release edit errors. 
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Lesson 13, Task 2 –  AMR AFRS Edit Checks 
 
After you have run your AMR Pre-Release Edit checks, corrected all critical errors, and made the 
necessary changes for warning messages, the next step is to run your AMR AFRS Edit checks.   
 
 Note:  The AFRS Edit checks will take a while to run (approximately 15 minutes).    Note:   You 
can select one or more packets to run the AMR AFRS Edits.    Note:  Another option if you believe 
your packet is ready to submit to OFM, is to skip the AFRS Edit checks and instead select the Submit 
Packet(s).  This option will run both the Pre-Release edit checks and the AFRS Edit check, if there are 
critical errors for either the Pre-Release or AFRS, the packet will not be submitted and an edit report 
will be available.  If the packet was not submitted due to an error, check the Most Recent Edit Report 
to view the error. 
 

1. Select a packet from the View Packet List screen that has passed all the Pre-Release critical 
errors.  In the right hand corner of the screen, select AMR AFRS Edits in the drop down, 
then select Run. 

 

 
 

2. If there are no critical AMR Pre-Release errors, you will receive this message.  Click OK.  
 

 Note:  If there are critical AMR Pre-Release errors, you must correct the critical AMR Pre-
Release errors before the AFRS Edit check will run. 
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 Note:  Once the Run button is selected a Traffic Light Indicator will appear in the row of the 
selected packet(s).  When performing an AFRS edit check you will get a yellow traffic light while it is 
running through the edit checks.  It will remain yellow until AFRS edit checks has finished.  You will 
receive an e-mail indicating whether AFRS has passed or you have errors.  Note: You will need to 
refresh the screen; this can be accomplished by clicking on the View Packet List tab at the top of the 
page or the Rows Load button.   If the packet has passed the AFRS edit checks, when you refresh your 
screen the traffic light will disappear.  If AFRS edit checks has failed you will receive a red traffic 
light.   
 
 

 
 
 
 Note:  If you receive a red traffic light, this means you have AFRS critical errors that will need to 
be corrected before submitting your packet to OFM.   The red traffic light will remain red until the 
AFRS critical errors are corrected and the AMR AFRS Edit report is run again.   
 Note:  The AFRS error messages may be difficult to understand what needs to be corrected in order 
to fix the error.  If you have questions, contact the DES Solutions Center. 
 
 Note:  If your packet has failed the AFRS edits check, you will receive an email message.  The 
message will state the following:  The AFRS edit checks have been completed and errors have been 
found.  Please view the “Most Recent Edit Report”.  The Most Recent Edit Report can be found on the 
View Packet List screen on the right hand side of the screen.  The Most Recent Edit Report will allow 
you to view the AFRS and AMR edits.  Most edits will have a link to Online Views.  From Online 
Views, you will see the data that caused the error.    
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Lesson 13, Task 3 –  Submit Packet(s) 
 
After all critical errors for AFRS and AMR Pre-Release have been corrected the packet can now be 
submitted to OFM. 
 
 Note:  The Submit process will run through both the AMR and AFRS edit checks, which will take a 
while to run (approximately 15 minutes).     Note:   You can select one or more packets to run the 
Submit Packet(s).    
 

1. Select a packet from the View Packet List screen that has passed all the Pre-Release and AFRS 
critical errors.  In the right hand corner of the screen, select Submit Packet(s) in the drop 
down, then select Run. 

 

 
 

2. If there are no critical AMR errors, you will receive this message.  Basically this message is 
telling you that the AFRS edit check is going to run.  Click OK.  

 

 
 
 Note:  Once the Run button is selected a Traffic Light Indicator will appear in the row of the 
selected packet(s).  When performing an AFRS edit check you will get a yellow traffic light while it is 
running through the edit checks, it will remain yellow while running the AFRS edits.    Note:  After 
the AFRS edits have run (approximately 15 minutes) you will need to refresh the screen, this can be 
accomplished by clicking on the View Packet List tab at the top of the page or the Rows Load button.   
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3. When the packet is submitted, you will receive the following email message.    
 

 
 

4.  After the packet is submitted to OFM, the Traffic Light Indicator will change from yellow to 
green and the status will change to Pending. 

 
 Note:  The packet will remain in Pending status until OFM has opened the packet. 
 
If the Submit has failed the following will happen: 
 
 Note:  If you receive a red traffic light, this means you have AFRS critical errors that will need to 
be corrected before submitting your packet to OFM.  The red traffic light will remain red until the 
AFRS critical errors are corrected and the packet is submitted again.    Note:  The AFRS error 
messages may be difficult to understand what needs to be corrected in order to fix the error.  If you 
have questions, contact the DES Solutions Center. 
 
 Note:  If your packet has failed the AFRS edits check; you will also receive the following email 
message:  The AFRS edit checks have been completed and errors have been found.  Please view the 
“Most Recent Edit Report” for more information.  The Most Recent Edit Report will allow you to view 
the AFRS and AMR edits.  Most edits will have a link to Online Views.  From Online Views, you will 
see the data that caused the error.  
 
After all critical errors have been fixed; perform steps 1 through 4 again to submit your packet. 
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Lesson 13, Task 4 –  Recall a Packet 
 
After a packet has been submitted to OFM, you can recall a packet.  
 
 Note:  In order for a user to recall a packet, they must be set up with the security to submit a 
packet.   Note:  The Recall Packet function can only be performed on a packet in Pending status.  
 Note:  Once the packet has been recalled the packet is no longer viewable by OFM. 
 

1.  Select a packet from the View Packet List screen that has been submitted to OFM and is 
pending status.  Select the Recall Packet in the drop down, then select Run. 

 

 
 
 Note:  You will receive the following message:   
 

 
 

2.  Select OK and the packet status will change to draft status. 
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LESSON 14 – CHART FEATURES 
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Lesson 14, Task 1 – Viewing Charts 
 
The Charts compare data for allotments and actuals.  The Charts tab can be found at the top of the 
View Packet List screen.  
 

 
 
 Note:  When selecting the Chart tab and viewing a chart, it is important to know the allotment data 
is only for packets in Pending, Review and Approved packet status.  Note:  The Data Type 
dropdown provides a selection for Operating or Capital packets, and will display accounts that exist in 
the allotment packets in the Account dropdown.   Note:  Actual data is from the prior biennium.  If 
there are months that are not closed from the prior biennium, the data included will be prior biennium 
allotments.    
 
 Note:  Charts can also be found when running a Pre-Release Report for an Operating Initial 
Allotment packet only.  However the only time a chart can be viewed from the Pre-Release Report is if 
the data in the Operating Initial Allotment packet caused a warning edit.  There will be a link to the 
Chart.  The allotment data in this chart does include Draft allotment data from the selected Operating 
Initial Allotment packet. 
From the Charts tab you may view the following charts: 

1. Allotted vs. Past Biennium Actual Expenditures-by Account — you have the choice of 
displaying the information by percentages or dollars and may select an account from the 
accounts contained in the Data Type packet selection you are viewing.  

2. Allotted vs. Past Biennium Actual Cash Disbursements-by Account — you have the choice 
of displaying the information by percentages or dollars and may select an account from the 
accounts contained in the Data Type packet selection you are viewing.  

3. Allotted vs. Past Biennium Actual Cash Receipts-by Account — you have the choice of 
displaying the information by percentages or dollars and may select an account from the 
accounts contained in the Data Type packet selection you are viewing.  

4. Allotted vs. Past Biennium Actual Revenue-by Account — you have the choice of 
displaying the information by percentages or dollars and may select an account from the 
accounts contained in the Data Type packet selection you are viewing.   

5. Allotted vs. Past Biennium Actual Expenditures-by Object — you have the choice of Data 
Type packet selection to display the information by percentages or dollars and fiscal period. 

6. Allotted vs. Past Biennium Actual Expenditures-by Program — you have the choice of 
Data Type packet selection to display the information by percentages or dollars and fiscal 
period. 

7. Allotment vs. Actual Current Biennium Activity – By Account – you have the choice of 
Data Type packet selection to display Cash or GAAP data.   
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• The system will run a biennial projection for an account. 

• There will be a beginning balance; the actual information will be based on transactions 
posted in AFRS, unclosed AFRS months will be provided from the allotments in TALS-
AMR.  The allotment data will contain only official packets and will include operating 
and capital allotment data.  Users will have the option to include allotment packets that 
are in Pending and Review statuses. 

• The chart will display the projected account balance for the entire account (all 
agencies).  The user can export the chart; the exported chart will show the detail for the 
account by agency. 

• The user will have the ability to export the data.  The data will export into a text file.  
The user will have the ability to open the text file using “Text Wizard”.  See Lesson 8, 
task 1 for more information on using the “Text Wizard”. 

 
1. To view a chart select the Charts tab.   
 
 Note:  By default the first chart that is viewable is Allotted vs. Past Biennium Actual Expenditures-

by Account.   
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2. To view another chart, select the chart from the dropdown arrow at the top of the dialog page. 
 

 
 
3.  Select the Format you’d like to view – Percentages or Dollars 
 Note:  By default the Format is Percentages. 
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4. The first four charts have another selection choice of Account – select the account you want to 

view.   Note:  The account choices will be the accounts for Operating data only and in Pending, 
Review and Approved Statuses. 
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5. The remaining two charts have another selection choice of Fiscal Period – select the entire 

biennium, or one fiscal year.   Note:  FY1 compares the first fiscal year of allotments to the first 
fiscal year of expenditures from the past biennium.  FY2 compares the second fiscal year of 
allotments to the second fiscal year of expenditures from the past biennium. 

 

 
 

6. To print a chart, select the Print button at the bottom of the dialog box.   Note:  The charts 
print in Portrait, in order to change to Landscape you will need to change it manually. 

 
TO DO - Hands on:  View charts and make selections between dollars and percentages, account, 
and/or fiscal periods. 
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LESSON 15 – REPORTS 



 

 151 

 
Lesson 15, Task 1 – Viewing and Running Reports 
 
There are two ways to view TALS reports.  One way is through Enterprise Reporting (ER).  See the 
tab below that takes you to ER to schedule reports.  This tab can be seen from any screen in TALS-
AMR. 
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The other way to run a report is through the View Packet List.  See the reports listed below.  Select a 
report and click the Run button.  When running the reports this way the parameters are already set to 
the preferred view of the OFM budget analysts.  This way you can run and view a report exactly the 
way your OFM budget analyst is looking at it if they choose it from this list of reports. 
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Enterprise Reporting is used to view the TALS-AMR reports.  When you’ve logged into ER you 
request the report using the standard ER report creation steps.  Each report has a set of parameters 
available for that report.  The detail reports will have more parameters than the summary reports.  The 
defaults for the parameters have been set to a high level view so that you do not need to make a lot of 
selections to get a usable report.  You may want to make some lower level selections to meet your 
needs.  The ‘Level of Detail’ parameters are used to select what level you want to view the data at, 
such as ‘Level of Detail for Program’ would mean do you want to see the data at the program, sub 
program, activity, sub activity, or task level? There are Expenditure, Revenue, Cash Receipts, Cash 
Disbursement, and Comparison reports available.  The reports available to date are: 
 
AMR001 – Allotment Expenditure Summary – provides a summary of expenditure and FTE 
allotment by program, account, account type, expenditure authority, and object for fiscal year and 
biennial periods.  The report displays information in five categories:  summary, allotted expenditures, 
unallotted, reserve, and comments. 
 
AMR002 – Allotment Expenditure Detail – provides a detail of expenditure and FTE allotment by 
program, account, account type, expenditure authority, and object by fiscal month, fiscal year and 
biennium.  This report can be requested at any level the data was entered into TALS-AMR.    Note: 
FTE is by GFS and other only – if detail by account is needed use the AMR002FTE report. 
 
AMR002FTE – Allotment Detail – provides a detail of the FTE allotments by account, expenditure 
authority, and object by fiscal month, fiscal year and biennium. 
 
AMR003 – Allotment Revenue Summary – provides a summary of the revenue allotment data by 
account and category for fiscal year and biennial time periods.   Note: The categories are State, 
Federal, and Private/Local. 
 
AMR004 – Allotment Revenue Detail – provides a detail of the revenue allotments by account, major 
source, and source by fiscal month, fiscal year, and biennium. 
 
AMR005 – Allotment Cash Disbursements Detail – provides a detail of the cash disbursements 
allotments by account by fiscal month, fiscal year, and biennium. 
 
AMR007 – Allotment Cash Receipts Detail – provides a detail of the cash receipts allotments by 
account by fiscal month, fiscal year, and biennium. 
 
AMR008 – Allotment vs. EA Schedule – compares allotment expenditure and FTE data with the 
Expenditure Authority Schedule (EAS) and shows variances. 
 
AMR009 – Allotted Revenue vs. Expenditure Variance (Federal and Private/Local Funds Only) 
– compares federal and private/local revenue and expenditure data for the allotment and shows where 
the revenue and expenditures do not match as required by Generally Accepted Accounting Principles. 
 
AMR010– Allotted Revenue vs. EAS Revenue Variance – provides a comparison of revenue 
allotments to the expenditure authority schedule (EAS) revenue control numbers for fiscal year and 
biennial time periods. 
 
AMR011– Allotted Expenditures vs. Cash Disbursements – provides a comparison of allotted 
expenditures to cash disbursement allotments.  The report displays the information by fiscal month, in 
spreadsheet form and in graph form. 
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AMR012– Allotment Revenue vs. Cash Receipts – provides a comparison of revenue allotments to 
cash receipt allotments.  The report displays the information by fiscal month, in spreadsheet form and 
in graph form. 
 
AMR013– Allotted Revenue vs. Expenditures (All Accounts) – compares allotted expenditures by 
account with revenue by account. 
 
AMR014– Projected Monthly Cash Balance – enables OFM and administering agencies to 
determine if an account will have a temporary cash deficit during the course of the biennium based on 
actual cash balances to date plus proposed and approved cash allotments for the remainder of the 
biennium.  This report will not include data from packets in Draft status. 
 
AMR015– Projected Fund Balance – shows the projected ending fund balance for each fiscal year 
based on the allotment data under review and previously approved.  This report will not include data 
from packets in Draft status. 
 
AMR016– Projected Cash Balance – shows the projected ending cash balance for each fiscal year 
based on the allotment data under review and previously approved.  This report will not include data 
from packets in Draft status. 
 
AMR017– Incremental Change from Previous Submittal – isolates changes within a packet that has 
been returned to the agency for revision and resubmitted to OFM for review. 
 
AMR018– Unanticipated Receipt Allotments – provides information to the legislative fiscal 
committees on executive spending authority granted to agencies by OFM.   
 
AMR019– Allotment Status– facilitates management of the allotment review process.  It enables both 
OFM budget analysts, agency budget analysts, and the Legislature to view the status of allotments and 
summarizes the number of allotment packets by status and purpose. 
 
AMR020– Unanticipated Receipt Approval Request –This report is used to convey the required 
information to OFM and the Legislature when requesting spending authority for unanticipated receipts.  
It replaces the former B20-1 form. 
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Task 1 – Hands On – Now we’ll request the AMR002 report 
 

1. Log in to Enterprise Reporting. 
2. Select the BASS Training folder. (skip if not in training) 
3. Select the Allotment Reports folder. 
4. Schedule the AMR002 report using the standard Enterprise Reporting report creation steps 

(Use the Schedule with Selection Values). 
 

 
 
The number of parameters will vary for each report.  The AMR002 has more than most of the other 
reports allowing for the most flexibility.  The Packet Number parameter will default to the most recent 
packet (or highest number).   

 
5. Select your packet number from the drop down arrow in the Packet Number parameter that 

you created in this training session. 
 
Level of Detail parameter – this parameter will determine at what level of detail you will view your 
data.  The choices are the elements that make up your PI.  If you want to view the data as a total for the 
agency the selection you would make is Agency.  If you want to see the data as it was entered into the 
system you would select Program Index.  You may select any level between agency and program 
index. 
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6. Select Program Index from the drop down arrow in the Level of Detail parameter. 
 
 

 
 

7. Click the schedule button in the upper right hand corner to schedule the report. 
8. Click refresh until the status states ‘Success’ 
9. Click the instance time to view the report 
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This is the first page of the multi-page report. 
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APPENDIX 1 – BUSINESS RULE NOTES 
 

General Application 
1. The BASS suite of applications does not support the use of internet browser navigation buttons, i.e. 

‘back arrow’ and ‘forward arrow’. You should avoid using the back arrow and forward arrow 
buttons available on your web browser tool bar when working in BASS.  Using these buttons will 
give unpredictable results depending on the screen you are on when used.     

2. It is extremely important to properly logout of the system when not in use.  There is a timeout 
provision included in the system.  If your session is inactive for 120 minutes the system will time 
you out.  Your packet may be flagged as in use.  If you login again with the same user ID it will 
clear the in use flag and you will be able to access your packet. The in use flag will be removed 
nightly.  You will know a packet has been flagged as in use when you try to work with it and it the 
system tells you that someone is using it. 

3. The row selection box can be found on the view packet list, coding structure and allotment details 
screens. 

4. In order for the application to work, you must disable your pop up blocker for this site.   

5. Three levels of security access 

o Read-Only 

 View packets 

o Edit Access 

 Add packets 

 Can modify unlocked allotment packets 

 Can update agency internal comments, contact information, and attachments in 
Pending and Review status 

 Can update agency internal comments in Approved status 

o Budget Operations 

 Lock/Unlock packets 

 Add packets 

 Delete packets not Locked in a status of Draft and Returned 

 Can modify locked allotment packets 

 Can update agency internal comments, contact information, and attachments in 
Pending and Review status 

 Can update agency internal comments in Approved status 
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TALS Component Fields 
 

Note: Validation of Codes and Indexes will be completed in the Pre-Release process 
Component 

Fields Expenditures 
- Option 1 

Expenditures 
- Option 2 

Cash 
Receipts 

Revenue Cash 
Disbursements 

Allotment Coding Structure 

Program Index Required Required Optional Optional Optional 
Organization Index Optional Optional Not allowed  Optional Not allowed  
Budget unit Optional Optional Optional Optional Optional 
AFRS Project Optional Optional Optional Optional Optional 
AFRS Sub Project Optional Optional Optional Optional Optional 
AFRS Project Phase Optional Optional Optional Optional Optional 
Budget Activity  Optional Optional Optional Optional Optional 
User Identified Field Optional Optional Optional Optional Optional 

Allotment Detail 

Account Not allowed Not allowed Required Required  Required 
Appropriation Index Required     Required       Not allowed  Optional * Optional * 
Capital Project 
Number 

Derived**   Derived**  Not allowed  Derived**  Derived**  

Major Source  Not allowed Not allowed Optional Required Not allowed 
Source Not allowed Not allowed Optional Required Not allowed 
Sub-source Not allowed Not allowed Optional Optional Not allowed 
Object Required Required Not allowed Not allowed Not allowed 
Sub Object Optional Optional Not allowed Not allowed Not allowed 
Sub-Sub Object Optional Optional Not allowed Not allowed Not allowed 
FTES (Number) Not allowed Not allowed Not allowed Not allowed Not allowed 
Interagency FTE Flag Not allowed Not allowed Not allowed Not allowed Not allowed 
Transportation FTE 
Flag 

 Not allowed  Not allowed Not allowed Not allowed Not allowed 

Agency External 
Comments 

Optional Optional Optional Optional Optional 

Agency Internal 
Comments 

Optional Optional Optional Optional Optional 

 

* For Cash Disbursements, Revenue, and Expenditure FTEs: Appropriation Index is Optional, if used 
the account will be derived from AI.  Either AI or Account can be entered, but not both. 
 
** Capital Project Number will be a derived field for all non-unanticipated receipt packet purposes.  
For Unanticipated Receipt packet purposes this field will be editable. 
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Fields Expenditures –
FTEs 

Expenditures – 
Unallotted 

Expenditures -
Reserve 

Allotment Coding Structure 

Program Index Required Required Required 
Organization Index Optional Optional Optional 
Budget unit Optional Optional Optional 
AFRS Project Optional Optional Optional 
AFRS Sub Project Optional Optional Optional 
AFRS Project Phase Optional Optional Optional 
Budget Activity  Optional Optional Optional 
User Identified Field Optional Optional Optional 

Allotment Detail 
Account Required  Not allowed Not allowed 
Appropriation Index Optional*  Required Required 
Capital Project Number Derived**  Derived**  Derived**  
Major Source  Not allowed Not allowed Not allowed 
Source Not allowed Not allowed Not allowed 
Sub-source Not allowed Not allowed Not allowed 
Object Optional Not allowed Not allowed 
Sub Object Optional Not allowed Not allowed 
Sub-Sub Object Optional Not allowed Not allowed 
FTES (Number) Required  Not allowed Not allowed 
Interagency FTE Flag Optional Not allowed Not allowed 
Transportation FTE Flag Derived  Not allowed Not allowed 
Agency External Comments Optional Optional Optional 
Agency Internal Comments Optional Optional Optional 
 

 
 
 

PREPARE AN ALLOTMENT PACKET 
Establish an AMR Allotment Packet 

 
1. Add Packet feature is not available for those with read only security access. 

2. When loading packet information by time period you will know the data is loading by the status 
bar in the lower right hand corner.  This shows quickly, so you might miss it. 

3. The Packet Number will remain listed as [unassigned] until the required packet elements have 
been selected and saved for the packet being added.  This is a system generated number and 
deleted packet numbers will not be reused. 

4. Biennium is required field that allows you to choose which one. 

5. Purpose is a required field that gives type of allotment. 

6. Program field is optional, and for informational use only.  There is no link to the Program field 
and the data contained in the packet.  This is required for DSHS. 
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7. Title is for informational use to quickly identify and describe the allotment packets data. 
Visible on the View Packets List screen.  This field can be updated for an allotment packet with 
a packet status of Draft or Returned. 

8. Packet Explanation (Agency External Comment) field is not required to save a packet, the 
OFM allotment instructions do require agencies to submit explanations in certain cases. 

9. Agency Internal Comment field is optional. 

10. Contact field is required, and defaults to contact information of person who created the packet, 
with option to change contact person.   

11. The contact can be changed in review and approved status. 

12. Attachments are optional.  You can attach Word, Excel, and PDF files. 

13. Lock Packet selection box allows staff with budget operations security to lock packets.  Once 
saved a lock will appear to the left of packet number and the Lock Packet title will change to 
Unlock Packet.  To unlock, simply click on the Unlock packet selection box and save again. 
This function can also be performed from the View Packet List Screen by choosing the Set 
Locks option. 

14. Packet Number is automatically assigned by the application.  Until the packet is saved it will 
display as [unassigned]. 

15. Status will remain in Draft status until the packet has been released for review by an OFM 
budget analyst for official packets or submitted for posting to AFRS for internal packets.  

16. In the Add Packet Screen the dropdown will default to the biennium selected on the View 
Packet List screen.  Once a packet has been saved this field cannot be updated. 

17. Packet Purpose selection is required for establishing a new packet, once a packet has been 
saved this field cannot be updated.  The packet purpose describes the reason for the allotment 
submittal.  Please see the allotment instructions for more information on the correct packet 
purpose type to use for particular allotments. 

18. Program is for informational use to quickly identify and sort allotment packets that contain 
allotment detail for one program. There is no system edit between the Program field selection 
and the allotment detail included in the packet.  The dropdown lists display official agency 
programs.  DSHS is the only agency that must use this field. 

19. Packet explanation is not required to save an allotment packet, but an explanation is required by 
the OFM allotment instructions in certain cases. Explanation text is required for official 
allotment submittals when a pre-release edit check warning message requires an explanation. 
Use this field to communicate to OFM the key assumptions and decisions in the allotment 
packet data. This text is visible to your OFM budget analyst.    

20. Agency internal comments are for informational use for the agency.  This text is only visible to 
your agency staff.   Used to communicate agency decisions and assumptions that describe the 
allotment packet data.   

21. The contact field is populated based on BASS security forms submitted to DES.  The chosen 
contact will be the person receiving e-mail issues in relation to the packet.  Currently there may 
be only one contact person chosen.  

22. Attachments are an optional field except for unanticipated receipts, for informational use only.  
If adding a packet, the Add Attachments button will only be enabled after the packet details 
have been saved. 
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23.  It is intended that all agencies, except DSHS, submit one packet for initial Operating and one 
for initial Capital allotments, if appropriate.  DSHS must create separate initial operating 

packets for each program and submit all of these packets at the same time. 

 
Include Packet Attachments 

 
1. You must save your packet before it will allow you to add an attachment. 

2. Attachment files are limited in size to 3MB. 

3. When adding an attachment the Description field is optional, and provides the ability to include 
a synopsis of the material for quick reference.  The description included will display on the 
View/Add/Update Packet screens. 

4. To view an attachment, the file must be selected prior to clicking the View tab.   

5. The view attachment dialog box will remain open even after you have closed the attachment.  
To close, “X” out of it. 

 
View Packet List (View/Update Packet, Delete Packet, and Set Packet Locks) 

 
1. Your security access will determine which functions are available to you.  There are 3 levels of 

security access:  read only, edit access, and budget operations. 

2. Those with read only access will only be able to view.  Edit access (as long as the packet is 
unlocked) and budget operations can view, add and update packets. 

3. The system will allow you to sort on none, or one or more columns. Each column header has 
three possible states (not sorted—indicated with no arrow, sorted ascending—indicated with an 
up arrow, sorted descending—indicated with a down arrow), which can be selected by clicking 
the text in the column header.   On the view packet list screen the sort default is Number in 
descending order. 

 

CREATE THE EXPENDITURE ALLOTMENT DATA 
Add Expenditure Coding Structure and Allotment Detail 

 
1. Coding Structures and Allotment Details can be added and updated for any packet in a status of 

draft or returned. 

2. Be careful when choosing the Delete All tab.  This will give you a warning, but once you say 
okay, all of your coding structure information and related details will be gone. 

3. The comment tab within coding structure is where you put comments referred to in the Pre-
Release Edits as component level comments. 

4. The allotment coding structure screen also includes a row selection box which allows you to 
choose how many rows of data you would like to see with the choice of 10, 20, 30 or All.  To 
get this to display the number of rows, make a selection and click Load. 

5. Program index is a required field. 

6. While the [Enter or Select a Program Index] box is highlighted you can hit the down arrow to 
see all program indexes available in your agency, or you can start typing which will bring up a 
series of program indexes, or type in the whole thing.  If the agency has many program indexes, 
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it cannot hold them all and will show a ‘…’ at the bottom.  To get to the codes further down 
you will need to start typing to reach them.  

7. Project is a hierarchical field, so if you want to enter a sub project you must enter a project first 
or if you want to enter a project phase you must enter both project and sub project first. 

8. To add additional coding you can choose the Add button at the bottom of the screen. By 
clicking the “Add” button the data is saved automatically; however, after the last code make 
sure to click the “Save” button. 

9. Allotment details can only be added for an existing coding structure and only one coding 
structure can be selected at a time.   

10. By default the only grid expanded on entry of a coding structure with no allotment details is 
Expenditure Allotment Details.  Expenditure sections: Expenditure Allotment Details, 
Unallotted Allotment Details, Reserve Allotment Details, Variance (Option 1 agencies only), 
and Staff Month Allotment Details.   

11. The allotment coding structure screen also includes a row selection box which allows you to 
choose how many rows of data you would like to see with the choice of 10, 20, 30 or All for all 
four components.  To get this to display the number of rows, make a selection and click Load. 

12. You have the ability to hide or expand grid details from view on the Expenditure Allotment 
Details screen.  By selecting the ‘+’ plus symbol to the left of the grid title, the grid expands for 
adding or viewing details.  Likewise the ‘-’ negative symbol to the left of the grid title collapses 
the grid. 

13. Expenditure Authority Index and Object are required allotment detail fields for both option 1 
and option 2 agencies.  For option 1 agencies these two required fields are entered as separate 
allotment details within the same coding structure.  For option 2 agencies, these two required 
fields are entered together in one allotment detail as depicted below.  

14. The EAI determines what fiscal period dollar amounts will be available.  For example if you 
choose a first year EAI, the second year dollar amounts will be grayed out and not available for 
input.     

15. For records that have an EAI that cannot be found in the statewide tables, the fiscal period is 
assumed to be Biennial.   

16. Once you hit save the dialog box will display as an “update” rather than an “add”.  
17. Your allotment detail should equal your EA schedule when complete.  

18. The Expenditure Allotment Details screen also includes a row selection box which allows you 
to choose how many rows of data you would like to see with the choice of 10, 20, 30 or All.  
To get this to display the number of rows, make a selection and click Load.   

19. For option 2 agencies: The first row, Total, will be a sub-total of all the amounts displayed in 
the grid.  The second row, Grand Total, will be a total of all the amounts if multiple pages of 
data exist.  In the image below the Grand Total would be the total of all the amounts on page 1 
and 2.   

20. Expenditure Authority Index and Object are required allotment detail fields for both option 1 
and option 2 agencies.  For option 1 agencies these two required fields are entered as separate 
allotment details within the same coding structure. 
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21. For Option 1 Agencies, variance is displayed in the expenditure grid.  Variance displays the 
difference between the sum of the objects and the sum of the appropriation indexes for each 
month. 

22. Fiscal month fields are available for input based on the EA code used to establish the 
expenditure authority index.  When updating, if dollars exist in fiscal months not consistent 
with the fiscal period control of the EA code, a Roll amounts button will be available.    

23. To remove dollar amounts from the read-only fiscal months, you can select a new expenditure 
authority index (consistent with the entry fiscal months) or select the Roll Amounts button.   

24. The Roll Amounts button will move dollar amounts to their corresponding fiscal month amount 
for the fiscal year control of the EAI. (For example: an EAI with a Fiscal Year 2 control, Fiscal 
Month 1 dollars are moved to Fiscal Month 13.)    

25. Within Allotment Details for allotted expenditures and FTEs (as well as cash disbursements, 
cash receipts and revenue) you have several choices on how to enter the dollar amounts.  You 
can manually enter them one at a time, paste them from an excel spreadsheet, enter one amount 
to repeat over the fiscal period, enter one amount to spread over the fiscal period, or enter one 
amount to spread quarterly over the fiscal period.  It is always recommended that you choose 
your EAI first to determine which dollar fields should be available to enter into. 

26. To enter dollar amounts manually you can use the tab and enter keys or highlight the dollar 
amount and do a Ctrl “C” for copy and go to the next dollar amount area and do a Ctrl “V” for 
paste. 

27. To enter dollar amounts using the paste function choose dollar amounts from an excel 
spreadsheet going either vertically or horizontally by highlighting them and doing either an 
edit/copy or Ctrl C, then click in the fiscal month you want to start pasting in, then click the 
paste button.  You can paste up to 24 dollar amounts; however, if you choose more amounts 
than you have months it will only paste the first 24 if a biennial EAI, or 12 if a fiscal year EAI.  
So be careful to choose the right beginning month when pasting dollar amounts. 

28. To enter dollar amounts using the repeat function choose which month you want it to start and 
then enter the amount you want repeated, then click the repeat button. 

29. To enter dollar amounts using the spread function choose which month you want it to start and 
then enter the amount you want spread over the fiscal period.  If necessary, it will round the last 
month of the fiscal period to equal the total amount you wished to spread. 

30. To enter dollar amounts using the quarterly function, choose which month you want it to start 
and then enter the amount you want spread quarterly over the fiscal period.  If necessary, it will 
round the last month of the fiscal period to equal the total amount you wished to spread.  If you 
use this function after using the other functions, it will only replace the quarterly amounts. 

 
Unallotted, Reserve and FTE Allotment Detail 

 
1. If you choose Account, expenditure authority index will not be available.  If you choose 

expenditure authority index, account will automatically fill in.  OFM only requires that FTEs be 
by GF-S 001 account or 996 for all other; however, you may identify specific accounts detail if 
you wish. 

2. You can choose to mark FTEs as Interagency FTEs for tracking purposes.   

3. The Transportation FTE box will be automatically flagged if the Account chosen is associated 
with a transportation Account. 
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4. When columns are locked the amount columns scroll underneath them. You will only see the 
scroll bar if the display is smaller than the grid. 

5. Capital project number is derived by using biennium, EA code (expenditure authority index), 
and agency for all allotments.  For unanticipated receipts this field will only be derived if it has 
been previously entered otherwise, the agency must enter it and it is editable.  For allotments 
other than unanticipated receipts this field is not editable.  In order for the system to derive 
capital project number, you must choose an expenditure authority index associated with a 
capital appropriation.  The dropdown menu returns all expenditure authority indexes valid for 
the agency, not just capital expenditure authority indexes. 

 
CREATE THE CASH DISBURSEMENTS ALLOTMENT DATA 
Cash Disbursements Coding Structure and Allotment Detail 

 
1. Coding structure is optional for cash disbursements allotments; however, the account must be 

identified as part of the allotment detail.  A blank coding structure would imply that the cash 
disbursement is allotted at the agency level.   

2. The Cash Disbursements Allotment Details screen also includes a row selection box which 
allows you to choose how many rows of data you would like to see with the choice of 10, 20, 
30 or All.  To get this to display the number of rows, make a selection and click Load.   

3. EAI is an optional field.  Account will automatically be entered if an EAI is chosen.  Account is 
a required field. 

 
Patterning Cash Disbursements 

 
1. Patterning is performed at the account level.   

2. The pattern takes the dollar amount you have entered for the account and prorates it monthly 
based on the previous biennium’s actuals or allotments.   

3.  If all months of the biennium are not final the pattern will use the allotment for those months.  

4. A pattern will only be created for accounts that have amounts entered. If the amount is left 
blank it is considered to be zero and no pattern will be created for that account.   It will replace 
any data previously in that account with a zero.  

5. A pattern cannot be created on an account that did not exist the prior biennium.  
6. A pattern can only be performed using a blank coding structure. 

7. The patterning message warning does not mean that it will delete account data already created 
in other coding structures.  Be careful not to duplicate your cash disbursements by creating 
coding structures with the same accounts used in patterning. 

 
CREATE THE CASH RECEIPTS ALLOTMENT DATA 

Cash Receipts Coding Structure and Allotment Detail 
 

1. Coding structure is optional for cash receipts allotments; however, the account must be 
identified as part of the allotment detail.  A blank coding structure would imply that the cash 
disbursement is allotted at the agency level.   

2.  
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3. The Cash Receipts Allotment Details screen also includes a row selection box which allows 
you to choose how many rows of data you would like to see with the choice of 10, 20, 30 or 
All.  To get this to display the number of rows, make a selection and click Load.   

4. Account is a required field while major source and source are optional fields for cash receipt 
allotments. 

 
Patterning Cash Receipts 

 
1. Patterning is performed at the account level.   

2. The pattern takes the dollar amount you have entered for the account and prorates it monthly 
based on the previous biennium’s actuals or allotments.   

3.  If all months of the biennium are not final the pattern will use the allotment for those months.  

4. A pattern will only be created for accounts that have amounts entered. If the amount is left 
blank it is considered to be zero and no pattern will be created for that account.   It will replace 
any data previously in that account with a zero.  

5. A pattern cannot be created on an account that did not exist the prior biennium.  
6. A pattern can only be performed using a blank coding structure. 

7. The patterning message warning does not mean that it will delete account data already created 
in other coding structures.  Be careful not to duplicate your cash disbursements by creating 
coding structures with the same accounts used in patterning. 

 

CREATE THE REVENUE ALLOTMENT DATA 
 

1. Coding structure is optional for revenue allotments; however, the account, major source and 
source levels must be identified as part of the allotment detail.  A blank coding structure means 
the revenue is allotted at the agency level.  

2. EAI is an optional field for revenue allotments, but account, major source, and source are 
required.  

3. Major source is a hierarchical field, so if you want to enter a source you must enter a major 
source first, or if you want to enter sub source you must enter both major source and source 
first.   

4. The Revenue Allotment Details screen also includes a row selection box which allows you to 
choose how many rows of data you would like to see with the choice of 10, 20, 30 or All.  To 
get this to display the number of rows, make a selection and click Load.   

 
IMPORT TEXT FILE 

Download the Import Template. 
 

1. The template format is in the required Import format.  Do not add, delete or rearrange columns. 
2. It will be the agency’s responsibility to ensure that the import file is in the proper format and 

the fields within the file meet the prescribed format (see appendix 3 for the Import 
Specification). 

 
Import Text File 
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1. Once your allotment data has been created using the proper import format, this file must be 

saved as a text file before importing.   

2. The packet into which the data will be imported must exist prior to selecting the Import tab.   

3. Option 1 agencies must have a separate row for expenditure EA Indexes and Objects.   

4.  Data can be imported into any packet in draft or returned status only.   

5. Can merge together a text file into an existing packet that already has data.   

6. When the Merge/Sum Amounts Together for Duplicates radio button is selected, the import 
will merge all new coding structure and allotment detail data for all components.  When there 
are duplicate coding structures and allotment details, the amounts will be summed together.   

7. When the Delete Original/Replace radio button is selected, the import will replace all Coding 
Structure and Allotment Detail data for all components.    

8.  If there are import errors, the text file will not import into the application.   

9. Importing the text file into a packet with allotment data will replace all Coding Structure and 
Allotment Detail data for all components.    

10.  Imported files cannot be larger than 3MB. 

11. If you perform an import for both the SPS Import and the Import Text File, first import the text 
file, then the SPS Import.  The reason the import should be performed in this order is because 
the Import Text File replaces all data and the SPS Import only replaces FTE, and expenditure 
object A and B data  

12. For Option 1 agencies, allotment details with an EA index will not be deleted, but will have 
their EA index amounts added to any new amounts from SPS.  

13. The Import file must be a text file.  
14. By selecting the Delete Original/Replace radio button, this import will delete and replace all 

data in the selected packet. 

15. By selecting the Merge/Sum Amounts Together for Duplicates will merge all new data and sum 
duplicate data amounts together, but will not delete data previously in the packet before the 
import.  This functionality would be used when you want to merge a text file into a packet that 
already has data. 

16.  Allotment Type Code for the following:    

expenditure = EXP 

 FTE = FTE 

 reserves = RES 

 unallotted = UNA 

 cash disbursement = CAD 

 revenue = REV 

 cash receipt = CAR 
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17. For an unsuccessful import you will receive a Text Import Error Report.   See Appendix 3 for 
the required import format.  The errors must be corrected before the import will upload 
successfully.  It is best to make your corrections in Excel rather than in the text file.  The reason 
is because the columns do not line up in the text file.  After making corrections in Excel you 
will need to save back to a tab delimited text file before importing. 

 
IMPORT SPS DATA 

 
1. The packet into which the data will be imported must exist prior to selecting the import tab.   

2. Data can be imported into any packet in a status of draft or returned.   

3. Can import a SPS Projection file into a packet that has existing data.    

4. When the Merge/Sum Amounts Together for Duplicates radio button is selected this import 
will merge any new data into the selected packet for FTEs and expenditure object A and B 
only.  Plus, if there is duplicate data (same coding structure and allotment detail for FTEs and 
expenditure object A and B only) the amounts will be summed together.   

5. When the Delete Original/Replace radio button is selected, this import will delete and replace 
any data in the selected packet for FTEs and expenditure object A and B only.  If importing 
both the Text File and SPS Data, import the Text File first and then the SPS Data.   

6. For Option 1 agencies, allotment details with an EA index will not be deleted, but will have 
their EA index amounts added to any new amounts from SPS. 

7. The Projection File list only includes projection files for the specific biennium of the selected 
packet. 

8. Both program index and EA index must exist in the SPS Projection File for the SPS data to 
be imported into TALS-AMR.  

9. The Salary & Benefit Rollup is referring to Expenditure Allotment Details EAI and not FTE.  
10. By selecting 001/996 Account, the FTEs that are 001 (GFS) will be imported as 001 and all 

other FTEs will be imported as 996.  If you have 001 (GFF), this will be imported as 996. 

11. By selecting Account, the FTEs will be imported by account. 

12. By selecting EAI, the FTEs will be imported by EAI.  

13. By selecting No Object, FTEs will be imported with no object 

14. By selecting Object, FTEs will be imported at the object level 

15. By selecting Sub-Object, FTEs will be imported at the sub-object level 

16. By selecting Sub-Sub-Object, FTEs will be imported at the sub-sub-object level  

17. By selecting the Delete Original/Replace radio button, this import will delete and replace any 
data in the selected packet for FTEs and expenditure object A and B only. 

18. By selecting the Merge/Sum Amounts Together for Duplicates radio button, this import will 
merge any new data into the selected packet for FTEs and expenditure object A and B only.  
Plus, if there is duplicate data (same coding structure and allotment detail for FTEs and 
expenditure object A and B only) the amounts will be summed together. 
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EXPORT 
 

1. Can only export one packet at a time.    

2. Will export allotment data into tab delimited text file. 

3. If modifications are needed, it is best to save the export text file into Excel, make your changes, 
save back to a tab delimited text file and then import back into TALS-AMR.   

4. You can deselect the appropriate Export selections by clicking the check boxes.   

5. When you want to modify the text file, it is best to make changes in an Excel file rather than in 
the text file (the reason is because columns do not line up with the headings in a text file).   

 
ONLINE VIEWS 

 
1. Online Views are not intended for printing.  The AMR reports through Enterprise Reporting 

can be used for printing allotment data.   

2. Online Views behaves differently depending on the Option of your agency.  Since Option 1 
agencies enter their expenditure data by Object and EAI separately they will also view that data 
separately. 

3.    The Filter tab allows you to specify the data and level of detail you want to see and how that 
data should be displayed to you on the screen.  The filter contains 4 tabs: 

• Packet – choice of expenditure, cash disbursement, cash receipt, and revenue component 
information.  Contains selections for packet number, purpose, status, program, and title.  
You also have the choice of viewing expenditures, staff months, unallotted, and reserves 
within the expenditures components. 

• Organization – contains coding structure information for program, organization, and project 

• Account – contains expenditure authority, account, and object choices 

• Summary – lists the filter summary 
4. Grouping and Displaying data – you will have the ability to create hierarchies of data by 

selecting to display elements at a particular group level by using the Group Lvl. combo box.  
Up to 4 group levels may be selected.   Each group level is displayed in the online view as a 
summary row with a “+” to expand the rows that contribute to that rollup.  If the element is to 
be displayed in the online view the Disp. box must be checked.  You may specify criteria to 
filter on or leave blank to return all data. 

5. A Group Lvl. must be chosen if a criterion is entered.   

6. At least one element must be selected to display. 

7. You may narrow your filter by defining the criteria you wish to view.  The Criteria may be 
entered manually into the criteria box or click on the “…” for a list and make your selections 
from the list.  You may enter criteria up to 255 characters.  A blank criteria box means all data 
will be returned. 

8. The ‘+’ indicates coding elements that contain hierarchically related data and can be expanded 
to group and display by those elements.  For example, Program expands into Program, Sub 
Program, Activity, Sub Activity and Task. 
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9. The criteria for these coding elements are entered in the text box next to its associated coding 
level, or can be selected from the lookup dialog.  You may enter a single criterion or multiple 
criteria elements by separating them with a comma. 

10.  Click on the ‘…’ at the left of the text box for the lookup dialog. 

11.  When delete is selected a confirmation dialog box will appear. 

12. After you save the dialog box will reappear with the update.  Click cancel to close the dialog 
box.  You will return to the previously expanded Online View.  If one of your sort criteria is 
something you change as an update or delete, the filter will re-run and may not display any 
information. 

13. For Option 1 agencies, if no criterion is selected for either Object or EAI on the Account tab, 
Expenditures by Account or EAI will display by default.  If Object criteria is selected on the 
account tab, but no EAI criteria then the Expenditures by Object will display only.  If both 
Object and EAI criteria are selected on the account tab then both grids will be displayed.   

 
PRE-RELEASE EDIT CHECK 

 
1. You can select one or more packets to run the AMR Pre-Release Edits 

2. There are three types of edits; critical, warnings and informational edits.  A number of the 
warning errors will prompt the user to provide an explanation in the packet for OFM about a 
particular pattern or condition in the allotments.  OFM will be able to see these warning 
messages as well and will be looking for those comments.  Your packet may be returned if the 
requested information is not provided.   

3. There are a couple of edit checks that compares allotments to actual.  This edit check is only 
performed on an Operating Initial packet purpose type when the Operating Initial packet 
allotments deviate more than 10% from the historical actuals.  When allotments deviate more 
than 10%, a warning message will display on the AMR Pre-Release report.  Also included in 
this warning message is a link to a chart that will display the comparison.     

4. The system won’t always provide a link depending on the type of error produced 

5. Online views will appear behind the AMR edit report so you can minimize or cancel the report 
(recommend minimizing if more than one error) or click on the online views in the background 
and the error report will automatically be minimized.  

6. Selecting the online view link from the AMR Edit Report will take you to the data that caused 
the error in online views.  To fix the error you must evaluate if the change needed is to the 
allotment information or if another action must be taken.  For example, if the error says “the 
program index XXXXX does not exist in AFRS“, the fix may be setting it up in AFRS not 
changing it in TALS AMR.   

7. Going to online views through the AMR Pre-Release edit takes you to the data that caused the 
error only.  However, when coming to online views through AMR Pre-Release Edits, you do 
not have the option to change your online views filter. 

8. For more information regarding the edits, see appendix 4 – Pre-Release Edits, which identifies 
the Edit #, Edit Type (Critical, Warning or Informational) and Description (and in some cases 
gives more detail about the edit than the Pre-Release Edit report does).  

9. The AFRS Edit checks will take a while to run (approximately 15 minutes).    

10. You can select one or more packets to run the AMR AFRS Edits.    



 

 171 

11. Another option if you believe your packet is ready to submit to OFM, is to skip the AFRS Edit 
checks and instead select the Submit Packet(s).  This option will run both the Pre-Release edit 
checks and the AFRS Edit check, if there are critical errors for either the Pre-Release or AFRS, 
the packet will not be submitted and an edit report.  If the packet was not submitted due to an 
error, check the Most Recent Edit Report to view the error.   

12. If there are critical AMR Pre-Release errors, you must correct the critical ARM Pre-Release 
errors before the AFRS Edit check will run. 

13. Once the Run button is selected a Traffic Light Indicator will appear in the row of the 
selected packet(s).  When performing an AFRS edit check you will get a yellow traffic light 
while it is running through the edit checks.  It will remain yellow until AFRS edit checks has 
finished.  You will receive an e-mail indicating whether AFRS has passed or you have errors. 
 Note: You will need to refresh the screen; this can be accomplished by clicking on the View 
Packet List tab at the top of the page or the Rows Load button.   If the packet has passed the 
AFRS edit checks, when you refresh your screen the traffic light will disappear.  If AFRS edit 
checks has failed you will receive a red traffic light. 

14. If you receive a red traffic light, this means you have AFRS critical errors that will need to be 
corrected before submitting your packet to OFM.  The red traffic light will remain red until the 
AFRS critical errors are corrected and the AMR AFRS Edit report is run again.    

15. The AFRS errors messages maybe difficult to understand what needs to be corrected in order to 
fix the error.  If you have questions, contact the DES Solutions Center. 

16. If your packet has failed the AFRS edits check, you will also receive the following email 
message. 

17. The last sentence of the email says to view the latest Prerelease report; to view run the Most 
Recent Edit Report.  The Most Recent Edit Report can be found on the View Packet List screen 
on the right hand side of the screen.  The Most Recent Edit Report will allow you to view the 
AFRS and AMR edits.  Most edits will have a link to Online Views.  From Online Views, you 
will see the data that caused the error. 

18. The Submit process will run through both the AMR and AFRS edit checks, which will take a 
while to run (approximately 15 minutes).     

19. You can select one or more packets to run the Submit Packet(s).    

20. Once the Run button is selected a Traffic Light Indicator will appear in the row of the 
selected packet(s).  When performing an AFRS edit check you will get a yellow traffic light 
while it is running through the edit checks, it will remain yellow while running the AFRS edits.    

21. After the AFRS edits have run (approximately 15 minutes) you will need to refresh the screen, 
this can be accomplished by clicking on the View Packet List tab at the top of the page or the 
Rows Load button.   

22. The packet will remain in Pending status until OFM has opened the packet. 

23. If you receive a red traffic light, this means you have AFRS critical errors that will need to be 
corrected before submitting your packet to OFM.  The red traffic light will remain red until the 
AFRS critical errors are corrected and the packet is submitted again.  

24. The AFRS errors messages maybe difficult to understand what needs to be corrected in order to 
fix the error.  If you have questions, contact the DES Solutions Center. 
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25. The last sentence of the email says to view the latest Prerelease report; instead run the Most 
Recent Edit Report.  The Most Recent Edit Report will allow you to view the AFRS and AMR 
edits.  Most edits will have a link to Online Views.  From Online Views, you will see the data 
that caused the error.  

26. In order for a user to recall a packet, they must be set up with the security to submit a packet.   

27. The Recall Packet function can only be performed on a packet in Pending 

28. Once the packet has been recalled the packet is no longer viewable by OFM 
 

CHART FEATURES 
 

1. When selecting the Chart tab and viewing a chart, it is important to know the allotment data is 
only data for Operating packets in Pending, Review and Approved packet status.  

2. Actual data is from the prior biennium.  If there are months that are not closed from the prior 
biennium, the data included will be prior biennium allotments.    

3. Charts can also be found when running a Pre-Release Report for an Operating Initial Allotment 
packet only.  However the only time a chart can be viewed from the Pre-Release Report is if 
the data in the Operating Initial Allotment packet caused a warning edit.  There will be a link to 
the Chart.  The allotment data in this chart does include Draft allotment data from the selected 
Operating Initial Allotment packet. 

4. By default the first chart that is viewable is Allotted vs. Past Biennium Actual Expenditures-by 
Account.   

5. By default the Format is Percentages. 
6. The account choices will be the accounts for Operating data only and in Pending, Review and 

Approved Statuses. 
7. FY1 compares the first fiscal year of allotments to the first fiscal year of expenditures from the 

past biennium.  FY2 compares the second fiscal year of allotments to the second fiscal year of 
expenditures from the past biennium. 

8. The charts print in Portrait, in order to change to Landscape you will need to change manually. 
 

REPORTS 
 

1. In the AMR002-Allotment Expenditure Detail report FTE is by GFS and other only – if detail 
by account is needed use the AMR002FTE report. 

2. In the AMR003-Allotment Revenue Summary the categories are State, Federal, and 
Private/Local. 
 

COPY FEATURES 
 

1. Any packet can be copied from, but only packets in draft status can be copied to.   
2. You do not need to select a packet purpose, you may go directly to Packet and make your 

selection. 
3. When a user wants to merge multiple packets and reverse the signs, here are the steps:  First 

merge all the packets you want to merge into one packet, create a new packet, copy the packet 
with the merged packets into the new packet and reverse the sign.   

4. Only one coding structure can be copied at a time.   
5. For the copy coding structure the Biennium, Packet Purpose, and Packet are not options at this 

time and are grayed out. 
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REVIEW ISSUES 

 
1. Issues and responses can only be added to packets in review and returned status.  Issues and 

responses can be viewed, but not changed in packets with approved status. 
2. The title is displayed on the review issues screen.  The body of the issue can only be seen when 

you expand the issue by selecting the “+”. 
3. For a dropdown list select the “…”. 
4. You can remove Online Views links from the Selected Links box by highlighting the link and 

clicking on the left-handed directional arrow. 
5. You have the option to specify an Attachment Title.  If an Attachment Title is not entered, it 

will default to the File name.    
6. Attachments can be Word, Excel, or PDF formats, and are limited in size to 3MB. 

 
FEATURES NOT INCLUDED IN INITIAL PACKET PREPARATION 

Quarterly Allotment Amendment 
 

1. The adjustment amount field was created to allow agencies to move allotment capacity from 
closed fiscal months without skewing the current month or changing the official allotment 
record for closed months.  The total adjustment from closed months can be placed into the 
adjustment month field and the current month amount will contain the actual change desired for 
that month.  The adjustment amount will show as a separate entry on the TALS-AMR reports.  
The adjustment amount will however be posted to AFRS in the current fiscal month. 

 
Unanticipated Receipt 

 
1. The unanticipated receipt (UAR) packet purpose requires that you use the unanticipated receipt 

form from within the application.  This keeps all documentation of the UAR in one location. 

2. When establishing an UAR you must set up an Appropriation Index through the AFRS tables 
as described in the Allotment Instructions and the State Administrative and Accounting Manual 
(SAAM) with at least one of them having an appropriation type of a 3 or 9.  This information 
must be in the AFRS tables before you submit your UAR or it will not pass the pre-release 
edits. 

3. For capital UAR packets, you must establish your coding in AFRS prior to creating the 
allotment in order for the capital project number to be editable in the system. 

4. All UAR packets must include an attachment of the grant award. 
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APPENDIX 2 – REPORT SAMPLES 
 
 

See Report Descriptions and Samples document. 
http://bass.ofm.wa.gov/basspr/library/report_tutorial_appendix_2.pdf 
 
 

APPENDIX 3 – IMPORT TEXT FILE SPECIFICATIONS 
 
 
EXP=Expenditures 
FTE=FTE 
RES=Reserves 
UNA=Unallotted 
REV=Revenue 
CAD=Cash Disbursements 
CAR=Cash Receipts 
 
See Import Specifications Document. 
http://bass.ofm.wa.gov/basspr/library/import_spec_appendix_3.pdf 
 
Note:  The Field Names are the column headings for the import text file template.  See attached. 
 

ImportTextFileTempl
ate.xls  

http://bass.ofm.wa.gov/basspr/library/report_tutorial_appendix_2.pdf
http://bass.ofm.wa.gov/basspr/library/import_spec_appendix_3.pdf
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APPENDIX 4 – PRE-RELEASE EDITS 
Type – C= Critical W= Warning I= Informational  

Edit 
# 

Type Description 

2 C A packet explanation is required for operating quarterly amendment 
allotments. 

3 W The total federal allotted expenditure dollar amounts must match the total 
federal revenue allotment dollar amounts. 

4 W The total local allotted expenditure dollar amounts must match the total 
local revenue allotment dollar amounts. 

5 W The difference of the total allotment FTE amounts compared to the total 
FTE amounts on the EA schedule must not be more than plus or minus 
one FTE.  Note: this check will only be performed against operating FTEs 
if only operating packets are submitted and against capital FTEs if only 
capital packets are submitted. 

7 W The total intra-agency transfer (object T) allotment dollar amounts must 
net to zero at the agency level. 

9 W The difference of the total allotted expenditure dollar amounts by object, 
fiscal year, and agency appropriated level compared to the actual amounts 
from the previous biennium must not be more than ten percent for initial 
operating packets.  The agency appropriated level will be the agency level 
except for agency 300, which will be the program level. 

10 W The difference of the total allotted expenditure dollar amounts by fiscal 
year and program level compared to the actual amounts from the previous 
biennium must not be more than ten percent for initial operating packets. 

12 W The difference of the total cash disbursement allotment dollar amounts by 
account and month compared to the actual amounts from the previous 
biennium must not be more than ten percent for initial packets. 

13 W The difference of the total cash receipt allotment dollar amounts by 
account and month compared to the actual amounts from the previous 
biennium must not be more than ten percent for initial packets. 

14 W The difference of the total revenue allotment dollar amounts by account, 
major source, and source compared to the total revenue dollar amounts on 
the EA schedule must not be more than ten percent.  The check will 
compare biennial amounts. 

16 C The total appropriated allotted, unallotted, and reserve expenditure dollar 
amounts must match the total appropriated expenditure dollar amounts on 
the EA schedule for official non-unanticipated receipt packets.  Note: this 
check will only be performed against operating amounts if only operating 
packets are submitted and against capital amounts if only capital packets 
are submitted. 

17 W The total non-appropriated allotted, unallotted, and reserve expenditure 
dollar amounts must match the total non-appropriated expenditure dollar 
amounts on the EA schedule for official non-unanticipated receipt 
packets.  Note: this check will only be performed against operating 
amounts if only operating packets are submitted and against capital 
amounts if only capital packets are submitted. 
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20 C Allotments must be made at or below the subprogram level for 
expenditure authority on the EA schedule at the subprogram level. 

21 C Allotments must not be made in closed months except for initial packets. 
22 C The total unallotted expenditure dollar amounts by EA code must not be 

less than zero. 
23 C The total reserve expenditure dollar amounts by EA code must not be less 

than zero. 
26 C Amounts can only be allotted in the fiscal period specified by the EA 

code on the EA schedule.   
27 C An organization index used in a coding structure must be predefined in 

AFRS. 
28 C A program index used in a coding structure must be predefined in AFRS. 
29 C A capital program index cannot be used in a coding structure of an 

operating packet. 
30 C An operating program index cannot be used in a coding structure of a 

capital packet. 
32 C A budget unit used in a coding structure must be predefined in AFRS. 
33 W A budget unit used in a coding structure must match the budget unit of the 

organization index used in the coding structure, if an organization index is 
used. 

34 C An AFRS project used in a coding structure must be predefined in AFRS. 
35 W An AFRS project used in a coding structure must match the AFRS project 

of the organization index used in the coding structure, if an organization 
index is used. 

36 C An AFRS subproject used in a coding structure must be predefined in 
AFRS, and must be a valid AFRS subproject of the AFRS project used in 
the coding structure. 

37 W An AFRS subproject used in a coding structure must match the AFRS 
subproject of the organization index used in the coding structure, if an 
organization index is used. 

38 C An AFRS project phase used in a coding structure must be predefined in 
AFRS, and must be a valid AFRS project phase of the AFRS subproject 
used in the coding structure. 

39 W An AFRS project phase used in a coding structure must match the AFRS 
project phase of the organization index used in the coding structure, if an 
organization index is used. 

40 C A major source used in an allotment detail must be predefined in AFRS. 
41 C A source used in an allotment detail must be predefined in AFRS, and 

must be a valid source of the major source used in the allotment detail. 
42 C A subsource used in an allotment detail must be predefined in AFRS, and 

must be a valid subsource of the source used in the allotment detail. 
43 C An object used in an allotment detail must be predefined in AFRS. 
44 C A subobject used in an allotment detail must be predefined in AFRS, and 

must be a valid subobject of the object used in the allotment detail. 
45 C A subsubobject used in an allotment detail must be predefined in AFRS, 

and must be a valid subsubobject of the subobject used in the allotment 
detail. 
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46 C An EA index used in an allotment detail must be predefined in AFRS.  A 
capital EA index cannot be used in an allotment detail of an operating 
packet.  An operating EA index cannot be used in an allotment detail of a 
capital packet.  An EA index with an unanticipated receipt EA code 
cannot be used in an allotment detail of a non-unanticipated receipt 
packet. 

47 C An account used in an allotment detail must be predefined in AFRS. 
49 C An organization index must be used in the coding structure of an 

allotment detail that contains an EA index that requires an organization 
index. 

52 C The total reserve expenditure dollar amounts by account, EA type, fiscal 
period, and EA character along with the total reserve expenditure dollar 
amounts on the EA schedule for legislative reserve packets must equal.  

53 C The total reserve expenditure dollar amounts by account, EA type, fiscal 
period, and EA character along with the total reserve expenditure dollar 
amounts on the EA schedule for governor’s reserve packets must equal.  

54 C An EA index containing an EA code with an EA type of X cannot be used 
in an allotment detail. 

55 C The total allotted expenditure dollar amounts by coding structure, object, 
and month must match the total allotted expenditure dollar amounts by 
coding structure, EA index, and month. 

56 C An expenditure component explanation is required if reserve dollars exist.  
Go to the expenditure coding structure screen for the packet and select the 
“Comment” tab.  Enter your comments in the Agency External Comment 
field. 

57 C An expenditure component explanation is required if unallotted dollars 
exist.  Go to the expenditure coding structure screen for the packet and 
select the “Comment” tab.  Enter your comments in the Agency External 
Comment field. 

59 I This is an information message identifying there are non-budget EA 
indexes in the packet. 

60 C An EA code of an EA index used in an allotment detail must exist on the 
EA schedule for official non-unanticipated packets except for EA codes 
of Z96, Z97, Z98, and Z99. 

61 C A major source of 07 cannot be used in revenue or cash receipt allotment 
details. 

62 C A major source of 09 cannot be used in revenue or cash receipt allotment 
details. 

64 C A program index and organization index used in a coding structure must 
match a valid program index and organization index combination for 
agency 300, if both a program index and organization index are used. 

65 C A program and EA index used in a coding structure must match a valid 
program and EA index combination for agency 300, if both a program 
and EA index are used. 

68 C Object F or W amounts are required to match the amounts for non-
budgeted EA indexes by month. 

69 C An attachment is required for Unanticipated Receipt packets.  Please 
attach grant documentation. 
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70 C The Unanticipated Receipt Form must meet certain requirements.    
71 C Unanticipated Receipt packets must have an allotment amount entered for 

Reserves when the "Yes" is selected for question number 1 on the 
Unanticipated Receipt Form. 

72 C Unanticipated Receipt packets must contain at least 1 expenditure, 
unallotted or reserve allotment with an EA Type 3 or 9. 

73 C The allotment packet does not have amounts entered 
74 C Internal packets can only use unanticipated receipt EA codes when it has 

been used in an unanticipated receipt packet prior to the selected Internal 
packet. 

75 C For each unanticipated receipt ea code that is used in an internal packet, 
the sum of allotted, unallotted and reserve expenditures must net to zero. 

76 C For Operating Initial, Operating Supplemental 1 and 2 packet purpose 
types there must be cash disbursement allotment detail amount(s) when 
there is allotted expenditure detail amount(s) (except for DSHS, which is 
only for submitted draft initial operating packets). 

77 W For all official packet purpose types, except Operating Initial, Operating 
Supplemental 1 or 2 or Revenue and Cash Adjustment packet purpose 
types must have a cash disbursement allotment detail amount(s) when 
there is allotted expenditure detail amount(s) (except for DSHS, which is 
only for submitted draft operating packets other than initial, supplemental 
one, supplemental two, and revenue/cash adjustment  packets). 

78 C For Operating Initial, Operating Supplemental 1 and 2 packet purpose 
types there must be cash receipt allotment detail amount(s) when there is 
revenue allotment detail amount(s) (except for DSHS, which is only for 
submitted draft initial operating packets). 

79 W For all official packet purpose types, except Operating Initial, Operating 
Supplemental 1 or 2 packet purpose types must have a cash receipt 
allotment detail amount(s) when there is allotted revenue detail amount(s) 
(except for DSHS, which is only for submitted draft operating packets 
other than initial, supplemental one, and supplemental two packets). 

80 C Accounts 03K, 277, 290 must only be in operating allocation and internal 
packet purpose types. 

81 W The total of allotted, unallotted, and reserve for accounts 03K, 277, 290 
must not exceed the EA Schedule, but can be less than the EA Schedule. 

82 C Accounts 03K and 290 must not be used in Revenue and Cash Receipt 
components. 

83 C For DSHS, when submitting a returned packet the total of appropriated 
allotted, unallotted, and reserve by program and EA code must match EA 
schedule (every EA code amount within the program for the packet being 
submitted must match the EA schedule).   

84 W For DSHS, when submitting a returned packet the total of non-
appropriated allotted, unallotted, and reserve by program and EA code 
must match EA schedule (every EA code amount within the program for 
the packet being submitted must match the EA schedule).   

85 W For DSHS, when submitting a returned packet the total of non-
appropriated allotted, unallotted, and reserve at the agency level and EA 
code must match EA schedule (every EA code amount within the 
program for the packet being submitted must match the EA schedule).   
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86 C The total of allotted, unallotted, and reserve for accounts 03K, 277, 290 
must not exceed the EA Schedule, but can be less than the EA Schedule. 

87 C The system requires that the total of allotted, un-allotted, and reserve for 
each appropriated expenditure authority code in the selected Allocation 
packet match the EA schedule for official packets. 

89 C The system requires that the total of allotted, un-allotted and reserve for 
each appropriated expenditure authority code for an Operating Quarterly 
(2-8) must net to 0 in each packet.   

90 C The system requires that the total of allotted, un-allotted and reserve for 
each appropriated expenditure authority code for Internal packet must not 
be greater than 0 for the selected Internal and previously submitted 
Internal Operating or Capital Internal packets.   
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	You may also update another users saved filter and save it as your own.
	2. When another users filter is displayed select Save Filter, give the filter a title and click Save.
	Note:  The filter will also be saved under your name.
	LESSON 12 – REVIEW ISSUES
	Lesson 12, Task 1 –  Creating and Responding to Review Issues
	2. To add an issue Select the Add Issue tab and the following dialog box will appear:
	3. Describe the issue in the body of the dialog box.
	4. Give the issue a title that easily identifies it.  ( Note:  The title is displayed on the review issues screen.  The body of the issue can only be seen when you expand the issue by selecting the “+”.
	5. Select who you want notified in the E-Mail Notify box.  ( Note:   For a dropdown list select the “…”.
	6. To add an Online View Link to your new issue, click the Attachments and Links tab.  Your previously saved Online Views will be displayed in the Stored Filters box.  You may choose one or more Stored Filters to be displayed along with your Issue.  S...
	7. To add an Attachment, click the Attachments and Links tab.  Select the Browse button to locate the file, click the Add button.  ( Note:  You have the option to specify an Attachment Title.  If an Attachment Title is not entered, it will default to ...
	8. When finished select the Save button.
	The following screen shot details the fields available from Review Issues:
	1. A blank check box related to issue number 1.  To add a response to the issue, you must check here and click the Add Response tab.
	2. Issue title.
	3. Body/Description of issue number 2 (only displayed when expand the issue).
	4. Response to issue number 2 (each additional response will be listed in order of response).
	5. From tells you who generated the issue or response.
	6. Message displays the written body/description of the issue or response.
	7. Attachments will show as a link (it will display the title given or default to the file name if no title is given).
	8. Links will show as a link if online view links were chosen.
	9. Date displays the date and time the issue or response was created.
	10. Resolved will show a check mark once your OFM budget analyst has considered and checked off the issue as resolved.
	11. Date created is the original date the issue was created.
	12. Last Update shows the last date of an issue/response related to the issue.
	13. Issue number 1.
	Lesson 12, Task 2 –  Responding to an Issue
	1. To respond to an issue select an issue and the Add Response tab and the following dialog box will appear:

	TO DO - Hands on:  Practice adding Issues and attachment
	LESSON 13 – PRE-RELEASE EDIT CHECK
	Lesson 13, Task 1 –  AMR Pre-release Edit Checks
	Lesson 13, Task 2 –  AMR AFRS Edit Checks

	( Note:  If your packet has failed the AFRS edits check, you will receive an email message.  The message will state the following:  The AFRS edit checks have been completed and errors have been found.  Please view the “Most Recent Edit Report”.  The M...
	Lesson 13, Task 3 –  Submit Packet(s)

	( Note:  Once the Run button is selected a Traffic Light Indicator will appear in the row of the selected packet(s).  When performing an AFRS edit check you will get a yellow traffic light while it is running through the edit checks, it will remain ye...
	4.  After the packet is submitted to OFM, the Traffic Light Indicator will change from yellow to green and the status will change to Pending.
	( Note:  The packet will remain in Pending status until OFM has opened the packet.
	If the Submit has failed the following will happen:
	( Note:  If your packet has failed the AFRS edits check; you will also receive the following email message:  The AFRS edit checks have been completed and errors have been found.  Please view the “Most Recent Edit Report” for more information.  The Mos...
	After all critical errors have been fixed; perform steps 1 through 4 again to submit your packet.
	Lesson 13, Task 4 –  Recall a Packet

	( Note:  You will receive the following message:
	2.  Select OK and the packet status will change to draft status.
	LESSON 14 – CHART FEATURES
	Lesson 14, Task 1 – Viewing Charts

	LESSON 15 – REPORTS
	Lesson 15, Task 1 – Viewing and Running Reports

	Task 1 – Hands On – Now we’ll request the AMR002 report
	2. The title is displayed on the review issues screen.  The body of the issue can only be seen when you expand the issue by selecting the “+”.
	3. For a dropdown list select the “…”.
	4. You can remove Online Views links from the Selected Links box by highlighting the link and clicking on the left-handed directional arrow.
	5. You have the option to specify an Attachment Title.  If an Attachment Title is not entered, it will default to the File name.
	6. Attachments can be Word, Excel, or PDF formats, and are limited in size to 3MB.

	See Report Descriptions and Samples document.

